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Preface This IBM® Redbook presents a business process management (BPM) “round trip” scenario, showing how a business can use a full business integration solution to complete the following tasks:     



Model and simulate a business process Develop and test an application to implement the business process Deploy and run the application on a server Monitor the application to observe pre-determined key performance indicators Import the observed data to make revisions to the original process model



The business scenario described in this document has been simplified to provide a full description of each stage of the BPM end-to-end process. To avoid an overly large and unwieldy document, the authors focus on specific tasks, elements, and details, and not on presenting all possible facets of a complex business process. Each IBM software product included in the full BPM cycle has a large number of features and capabilities. For details on all of the available functions of these products, see the help documentation included with each product. The redbook is structured into five parts: 1. Business process management—This part provides a general introduction of the subject and an overview of the scenario that is used throughout the document. 2. Modeling the business—This part describes how to use WebSphere® Business Modeler to model the business process and its resources, simulate the process, and analyze the simulation results. Finally it introduces the business measures defined for monitoring the process. 3. Development and deployment—This part described how to implement the business process application, exported from the Modeler, using WebSphere Integration Developer and WebSphere Process Server. 4. Monitoring the application—This part describes how to use WebSphere Business Monitor to monitor the running application and measure the business process. 5. Continuous process improvement—This part provides information about the round trip scenario of improving the model based on the measurements, and regenerating and redeploying the modified application for further measurements.
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Part 1



Part



1



Introduction In Part 1 we introduce the concepts of business process management, the IBM process integration products that support business process management, and the case study, a company named ClipsAndTacks, that we use throughout the rest of the book.
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Chapter 1.



Business process management In this chapter we introduce the concepts and benefits of business process management (BPM) and service-oriented architecture (SOA) that enables business value through operational flexibility, responsiveness and reuse. We also introduce the Service Component Architecture (SCA) and Services Data Objects (SDO) as building stones for the SOA architecture.
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What is a business process? If you search the Web for a definition of business process, you find many definitions. All these definitions contain certain common elements:  A business process is triggered by a business event.  A business process has an input and creates an output that is of value to the organization, its stake holders, or its customers.  A business process is composed of related structural activities. Material and/or information flows between the process activities.  A business process can be part of a larger process and can include or depend on other business processes.  A business process can be viewed as the workflow for a use case.  A business process usually depends upon several business functions for support, for example, IT, personnel, and accommodation.



What is business process management? Business process management (BPM) leads to business innovation and optimization by implementing business strategy through modeling, developing, deploying and managing business processes throughout their entire lifecycle. BPM acts as an enabler for the businesses in defining and implementing strategic business goals and then measuring and managing company’s financial and operational performance against these goals. The power of optimal results from the BPM lifecycle activities is derived from the integrated set of the robust technology infrastructure and tools. Business process management provides a convergence of technology that removes business and IT constraints through integration and enhanced technology to help streamline business transformation. These capabilities provide tight integration of operational and analytical environments, business and IT environments, and strategy with daily operations. Business process management combines business processes, information, and IT resources, aligning your organization's core assets—people, information, technology, and processes—to create a single integrated view, with real-time intelligence, of both its business measurements and IT system performance. This integration of resources allows your organization to obtain business information faster, respond more quickly to market trends and competitive threats, and improve operational efficiencies and business results—all attributes of an on demand enterprise.
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Benefits of BPM BPM allows for an enterprise to be flexible and responsive to the ever changing on-demand business through the optimization and automation of the business processes to:  Identify and eliminate redundancies and bottlenecks  Reduce risk by gaining an understanding of process impacts prior to operationalizing  Decouple business integration logic from its underlying implementation code  Increase portability and decrease maintenance cost by being based on industry standards  Automate process implementation, eliminate manual deployment tasks  Immediately execute new business rules and processes  Visualize actual process performance against key performance indicators  Pinpoint future process improvements The robust business process management solution will provide powerful tools for the business and IT side of the business to meet their challenges:  The business executive needs: – Revenue growth with cost containment – Responsiveness to business conditions and ability to pursue new market opportunities – Improving internal skills, capabilities and leadership as first step toward growth  The challenges for the IT executive are: – Aligning IT and business goals to grow revenue and contain costs – Building responsiveness and agility into the organization through IT – Enabling people and teams to be more effective through IT



Information about business process management You can find definitions and more information about business process management on the Internet, for example:  Wikipedia: http://en.wikipedia.org/wiki/Business_Process_Management



 Business Process Management Initiative: http://www.bpmi.org/
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IBM business process management solution The IBM process integration portfolio provides capabilities required for the delivery of the comprehensive enterprise wide business process management strategies and solution. It offers a holistic approach to transform and manage a business by aligning strategic and operational objectives with business activities and supporting IT services. The IBM BPM solution includes development tools, used to implement custom artifacts that leverage the infrastructure capabilities, and business performance management tools, used to monitor and manage the runtime implementations at both the IT and business process levels. Business process management allows companies to implement the continuous end-to-end business process lifecycle in an open environment (Figure 1-1). Websphere Integration Developer



Webphere Process Server



- Discover - Design, construct, and test - Compose



- Integrate people - Integrate processes - Manage and integrate information - Run and manage complex applications



Websphere Business Modeler



Websphere Business Monitor



- Gather requirements - Model, design & simulate - Define business metrics



- Monitor business metrics and runtime - Dashboards, scorecards



Figure 1-1 Business process management lifecycle



The IBM BPM solution component tools support the following major activities:  Model—Capture, simulate, analyze and optimize business models to reduce risk and increase flexibility  Assemble—Develop, assemble and test integrated solution
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 Deploy—Direct deployment of models and policies to realize business intent  Manage—Manage the deployed models: – Monitor and correlate metrics and alerts in real-time from internal and external sources to gain visibility into the business and IT performance – Analyze performance results to gaining insight into the business metrics and information for contextual based decision making – Act by responding at the right time to insights through collaboration, optimization, and automation to excel One key feature of the IBM business process management is the linkage between the development platform and the business performance management services. It is addressed in the Governance & Processes section in Figure 1-1:  Governance reflects all corporate guidelines  Processes covers the business performance management area This functionality enables the delivery of runtime data and statistics into the development environment to allow for the completion of the analyses that drives iterative process re-engineering through a continuous business process improvement cycle.



Business performance management Business performance management tools incorporate monitoring capabilities that aggregate operational and process metrics in order to efficiently manage systems and processes. Managing these systems requires a set of capabilities that span the needs of IT operations professionals and business analysts who manage the business operations of the enterprise. These capabilities are delivered through a set of comprehensive services that collect and present both IT and process-level data, allowing business dashboards, administrative dashboards, and other IT- level displays to be used to manage system resources and business processes. Through these displays and services, it is possible for line-of-business (LOB) and IT personnel to collaborate to determine, for example, what business process paths may not be performing at maximum efficiency, the impact of system problems on specific processes, or the relationship of system performance to business process performance. This collaboration allows IT personnel and assets to be tied more directly to the business success of the enterprise than they traditionally have been.
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For more information about business performance management, refer to:  IBM business performance management community: http://www.ibm.com/software/info/topic/perform/partnerpage.html



 Wikipedia: http://en.wikipedia.org/wiki/Business_performance_management



IBM business process management products The BPM solution consists of four separate products:    



WebSphere Business Modeler WebSphere Integration Developer WebSphere Process Server WebSphere Business Monitor



Together, these products enable businesses and other organizations to plan and implement a unified business process strategy based on realistic simulations and observed data. At a high level, here is how you use these products together to get the right BPM solution for your business needs:  With Modeler you to begin the cycle by designing the optimal business process for a particular case. Typically, Modeler is used by a business analyst.  With Integration Developer you implement the model by creating the application code to automate the model and to access subsystems, such as databases and enterprise information systems. Integration Developer is used by a developer who integrates services to create an application, and an application programmer who focuses on the development of particular services.  Process Server provides the production server to run and manage the application you create. Typically, a system administrator works with Process Server.  Monitor provides real time performance monitoring of the application. Monitor is usually set up and administered by a system administrator. Once built, improvements to the model and application are on-going. For more information about the IBM business process management products, refer to: http://www.ibm.com/developerworks/websphere/zones/businessintegration/
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Service-oriented architecture (SOA) Service-oriented architecture (SOA) is the IT model which enables business value through operational flexibility, responsiveness, and reuse. SOA is an application framework that takes everyday business applications, breaks them into individual business functions and processes, called services, and then inter-relates them through well-defined interfaces and contracts. The interfaces are defined in a neutral manner that is be independent of the hardware platform, the operating system, and the programming language in which the service is implemented. This allows services, built on a variety of such systems, to interact with each other in a uniform and universal manner. SOA is an evolution as opposed to a revolution. The growing market momentum around SOA means that companies that compete with you are adopting SOA for strategic advantage. SOA would be impossible without industry standards. While there have always been standards proposed and declared in the IT world, finally there are the critical mass of very broad industry support to firmly establish that the current SOA standards are real, meaningful, and are here to stay.



Benefits of SOA Establishing a service-oriented architecture can help prepare both IT and business processes for rapid change. Even in the early stages of adopting an SOA, your organization will benefit from:  Increase revenue—Create new routes to market and create new value from existing systems  Provide a flexible business model—React to market changes more quickly  Drive down cost—Eliminate duplicate systems, build once and leverage, and improve time to market  Reduce risk and exposure—Improve visibility into business operations The SOA approach can bridge the gap between what you want your business to accomplish and the infrastructure tools you need to get there:  Decrease development and deployment cycle times by using pre-built, reusable services building blocks  Integrate across the enterprise—even historically separate systems—and facilitate mergers and acquisitions of enterprises  Reduce cycle times and costs by moving from manual to automated transactions  Make it easier to do business with business partners by increasing your flexibility
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 Brings adaptable, scalable solutions to complex business problems by using best practices, such as layering and loosely-coupled components



IBM SOA foundation The IBM SOA foundation is an integrated, open set of software, best practices and patterns that provides you with what you need to get you started with SOA. The SOA foundation provides full support for the SOA lifecycle through an integrated set of tools and runtime components that allow you to leverage skills and investments across the common runtime, tooling, and management infrastructure. The components are modular allowing you to pick and choose the pieces you need to deliver an immediate impact while knowing that what you pick will work with pieces you add later on. In addition, the SOA foundation is scalable allowing you to start small and grow as fast as your business requires. The SOA foundation provides extensive support for business and IT standards; facilitating greater interoperability and portability between applications. It can also help you to leverage SOA to extend the value of the applications and business processes that are running your business today. The SOA reference architecture (Figure 1-2) is a way of looking at the set of services that go into building an SOA. These capabilities can be implemented on a build as-you-go basis allowing capabilities and project level solutions to be easily added as new requirements are addressed over time. The backbone of the reference architecture is the enterprise service bus (ESB) that facilitates communication between services. he reference architecture is a great tool for laying out roadmaps for pursuing SOA. Every components included in this architecture is provided by separate IBM products. The highlighted parts show the components which address the business process management area.
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Business Monitoring
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Interaction Services
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Information Services
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Master Data Management Information Integration Data Management



IT Service Management
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Business Innovation & Optimization Services Business Modeling



Build Interoperability



Mediation
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Registry



Security



Events
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Partner Management Protocol Document Handling



Component Data Edge
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Apps & Info Assets



Deployment
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Infrastructure Services Workload Management



Virtualization
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Figure 1-2 IBM SOA reference architecture



This service-oriented architecture provides a modular, scalable, portable and interopable environment to support the equivalent aspects in the business area. The reference architecture shows the tight integration with the others IT critical aspects such as security, IT monitoring, virtualization, and workload management.



IBM BPM solution on the SOA foundation The BPM solution available from IBM enables service-oriented, end-to-end process management for your organization based on SOA. Its SOA component applications enables businesses and organizations to plan, develop, implement, and improve their processes. This solution lets organizations closely scrutinize costs, scheduling, resources, workflow, and other factors that affect the efficiency and viability of a given process, and determine the most effective methods for revising and improving that process.



Service Component Architecture (SCA) Service Component Architecture takes advantage of the emerging computing trend called service-oriented architecture (SOA), which structures IT assets as a series of reusable services that perform a business function.
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Service Component Architecture (SCA) is a new technology to simplify application development and implementation in a service-oriented architecture (SOA). With SCA, customers will be able to more easily create new and transform existing IT assets into reusable services that may be rapidly adapted to changing business requirements. Furthermore, these new technologies greatly reduce complexity associated with developing applications by providing a way to unify these services regardless of the programming languages they were written in and the platforms used to run them. By structuring applications as a series of services, IT assets become more agile and organizations are better able to align their investments in dynamic business environments. In addition, adopting these new standards will provide organizations a higher degree of investment protection, as they will be able to reuse services with a variety of middleware technologies. SCA provides an open, technology-neutral model for implementing IT services defined in terms of a business function, and do not unnecessarily expose the programmer to the complexity of traditional middleware programming. SCA also provides a model for the assembly of business solutions from collections of individual services, with control over aspects of the solution such as access methods and security. SCA gives developers and architects the ability to represent business logic as reusable components that can be easily integrated into any SCA-compliant application or solution. The resulting application is known as a composite application.



Service Data Objects (SDO) Service Data Objects is a technology that was originally developed as a joint collaboration between BEA and IBM and is now being developed by BEA, IBM, Oracle, SAP, Siebel, Sybase and XCalia. SDO is designed to simplify and unify the way in which applications handle data. Using SDO, application programmers can uniformly access and manipulate data from heterogeneous data sources, including relational databases, XML data sources, Web services and enterprise information systems. SDOs specify a standard way to access data and can be used to modify business data regardless of how it is physically accessed. Developers and architects do not need to know the technical details of how to access a particular back-end data source in order to use SDO in their composite applications. Consequently, they can use static or dynamic programming styles and obtain connected as well as disconnected access.
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SDO complements SCA by providing a common way to access many different kinds of data. The specification reduces the skill levels and time required to access and manipulate business data. Today, a multitude of APIs are used to manipulate data. These APIs tend to tightly couple the source and target of the data making their use error-prone and subject to breaking as business requirements evolve. SDO makes it easier to use and realize the value of these APIs without having to code directly to them.



Information about SCA and SDO In response to requests from customers and independent software vendor partners, IBM is jointly delivering two specifications for building systems that use a service-oriented architecture (SOA), which aim to provide developers with simpler and more powerful ways of constructing applications based on SOA: Service Component Architecture (SCA) and Service Data Objects (SDO). These specifications are available at: http://www.ibm.com/developerworks/webservices/library/specification/ws-scas dosumm/ http://www.ibm.com/developerworks/webservices/library/specification/ws-sca/ http://www.ibm.com/developerworks/library/specification/ws-sdo/



More on business performance management There is no standardization of terms in this area. For example, Meta Group and Aberdeen use business performance management (BPM), Gartner refers to corporate performance management (CPM), and companies such as PeopleSoft and Business Objects use the term enterprise performance management (EPM). IBM has adopted the business performance management term when referring to performance management practice and solutions. As a first deliverable, the business performance management standards group has developed a common definition of business performance management that provides appropriate context for performance management, including the following principles:  BPM is a set of integrated, closed-loop management and analytic processes, supported by technology, that address financial as well as operational activities.  BPM is an enabler for businesses in defining strategic goals, and then measuring and managing performance against those goals.
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 Core BPM processes include financial and operational planning, consolidation and reporting, modeling, analysis, and monitoring of key performance indicators (KPIs) linked to organizational strategy. The business performance management addresses metrics, methods, processes and associated systems used for the purpose of monitoring and managing the business performance of an enterprise including:  Encompasses balanced scorecards, operational dashboards, business activity monitoring, budgeting/planning/forecasting,  Leverages business intelligence, systems dynamics, Sarbanes-Oxley (SOX), six sigma, value creation, process management, and organizational design,  Requires a holistic vision of how to align business decisions and activities with strategic and operational objectives, though Implementation is typically along an incremental route-map.



Summary In this chapter we introduced business process management and the IBM business process management solution. We also touched on the relationship between business process management and business performance management.



14



Business Process Management: Modeling through Monitoring



2



Chapter 2.



Product overview This chapter provides an overview of the core WebSphere process integration products. These products support complete business process management lifecycle with modular approach. WebSphere process integration products enable you to:  Model, simulate, and analyze complex business scenarios quickly and effectively before they are implemented.  Transform existing processes to be dynamic and adaptive to deliver cost effective business agility.  Allow users to monitor the business processes they have implemented so that they can continuously make improvements to them. In this chapter we introduce these products:  WebSphere Business Modeler Version 6  WebSphere Integration Developer Version 6  WebSphere Process Server Version 6  WebSphere Business Monitor Version 6
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WebSphere Business Modeler Version 6 IBM WebSphere Business Modeler (Figure 2-1) is a business process modeling tool that enables you to model, design, simulate, analyze and generate reports for your business processes, integrate your new and revised process, and define your organizations, resources and business items. Accurate definition and modeling business processes is a critical factor in improving business performance. A business process is defined by interactions that occur between an organization's components and its environment as the organization pursues its business objectives. Business processes are often complex because of numerous incremental changes that are made in reaction to business circumstances. Without formal process documentation and process management systems, these process complexities can burden an organization with unnecessary hindrances and bottlenecks. A well-constructed business process model can help you locate and eliminate those hidden inefficiencies, costs and delays.



Figure 2-1 WebSphere Business Modeler
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Complete and robust process modeling tool A business process model is a visual representation of a process that contains supporting information. To create effective models, you must have a well-designed modeling structure that ensures consistent and complete representation of relevant information, including normal operations as well as alternatives and exceptions to standard procedures. You can use business process models to achieve many goals, including the following:    



Documenting existing procedures Determining requirements for staff, systems, and facilities Planning changes to existing processes and systems Testing and analyzing existing and proposed processes



WebSphere Business Modeler enables you to:      



Transform business process for automation Separate your business process model from its underlying implementation Create business processes that are based on industry standards Leverage skill sets of business and IT professionals Collaborate with team members Simulate and analyze business process



Leverage skill sets of business and IT professionals Whether you are a business generalist or an IT specialist, WebSphere Business Modeler provides the versatility to fit your particular set of skills. Using WebSphere Business Modeler, professionals with different scopes of interest and expertise can build process models to meet a wide range of business objectives. From the business analyst who requires a high-level view of a process to drive strategic decisions, to the program developer who uses a process model as the framework for a new application, competitive businesses require a versatile modeling tool that has the flexibility to meet the needs of both business and technical professionals.



Collaborate with team members WebSphere Business Modeler provides a built-in capability to connect with a separate product, WebSphere Business Modeler Publishing Server. WebSphere Business Modeler Publishing Server enhances WebSphere Business Modeler by providing a way to publish business processes and related business information, such as organization diagrams, to a secure Web site. This capability supports the development, documentation, and dissemination of business process models on an enterprise and worldwide scale. By publishing business processes in a Web-based format, multiple people on multiple teams around the globe can view and contribute to the development of the business processes.
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Simulate and analyze business process WebSphere Business Modeler provides a simulation function that lets you simulate and analyze your processes under any set of circumstances. When you simulate runtime processing, WebSphere Business Modeler provides an animated view of the business process in action. You can specify a wide variety of different conditions for the simulation, including the rate and composition of process inputs and the number of personnel and system resources available to handle the process. Through simulation you can quickly determine how the performance of your business process is affected in various real or hypothetical conditions.



Transform business process for implementation WebSphere Business Modeler enables you to transform business process models to IT-level models. You can export a Business Process Execution Language (BPEL) version of a business process model, then use WebSphere Integration Developer to import the BPEL model and use this as a basis to create an application.



Revolutionize business flexibility Because business environments are constantly changing, requiring continual fine-tuning of processes, business improvement is a perpetual race. WebSphere Business Modeler facilitates communication between business organizations by allowing you to create a process model that has far broader uses than a static drawing. Furthermore, WebSphere Business Modeler delivers cost saving benefits by providing a single tool that effectively utilizes the same process information for many purposes, reducing the duplication of effort required by using multiple, incompatible tools.



More information For more information about WebSphere Business Modeler, refer to: http://www.ibm.com/software/integration/wbimodeler/
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WebSphere Integration Developer Version 6 IBM WebSphere Integration Developer (Figure 2-2) is the integration tool you use for all your process integration requirements. It allows you to build flexible, composite applications by wiring service components with minimal skills based on service-oriented architecture (SOA). IBM WebSphere Integration Developer, Version 6 software is Eclipse technology-based tooling designed to enable you to rapidly assemble business solutions based on a composite application development framework and using minimal programming skills. With WebSphere Integration Developer, you can author SOA-based services and choreograph them into business processes that you can deploy on IBM WebSphere Process Server. WebSphere Integration Developer offers a role-based development experience that specifically targets the integration developer on a single and integrated Eclipse platform.



Figure 2-2 WebSphere Integration Developer
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WebSphere Integration Developer is the tool for all your integration requirements and fully implements the SOA. SOA and the Service Component Architecture (SCA) enable you to convert and use your existing IT architecture as reusable service components. The framework is comprehensive and extensive, which helps you transform your enterprise to SOA by leveraging your existing IT architecture. Because WebSphere Integration Developer is based on standards-based technologies, such as Web Services Description Language (WSDL), XML Schema Definition (XSD) and Business Process Execution Language (BPEL), you can model, implement and deploy complex composite applications without extensive knowledge of the underlying implementation. WebSphere Integration Developer is a fully integrated development environment based on the Eclipse 3 platform. Its graphically rich interface allows developers to create composite business applications by wiring service components with minimal skills and agnostic of underlying programming implementations. It has fully integrated testing, debug and deployment environment that allows you to easily deploy to WebSphere Process Server. Once deployed, you can dynamically change and adapt to changes with its rich features, such as business rules, selectors, and state machines. WebSphere Integration Developer complements IBM WebSphere Business Modeler Version 6, and can be used in conjunction with IBM Rational Software Architect Version 6 and IBM Rational Application Developer Version 6. When combined into a single integrated development environment (IDE), these products provide a complete suite of tools to model, simulate, author, and deploy composite SOA applications. WebSphere Integration Developer delivers a rich set of features to assemble, deploy, and manage business processes:  Import business models from WebSphere Business Modeler and transforming to BPEL flows to automate the business processes  Drag and drop features to create business processes  Widgets to wire service components including: – – – – – – – – – –
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Business processes Human tasks Business state machines Business rules Supporting services Interface maps Business object maps Relationships Selectors Java™ objects
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 Online library to browse and reuse service components  Import services from ERP and EIS systems, such as PeopleSoft, SAP, CICS®, and IMS™ In addition, WebSphere Integration Developer enables:  Composite application development: WebSphere Integration Developer allows you to render existing applications as standards based services. Services can be assembled together without the associated complexities of the underlying IT required for complex business applications. Now, you start building a solution from the services available to you and build only the services that don’t exist, enabling true incremental solution.  Flexibility for managing deployed processes: WebSphere Integration Developer allows you to test and debug business processes, and deploy them on WebSphere Process Server with a few mouse clicks. WebSphere Integration Developer’s rich GUI intensive features allow for change and management of deployed processes with minimal skills and disruption.



More information For more information about WebSphere Integration Developer, refer to: http://www.ibm.com/software/integration/wid/



WebSphere Process Server Version 6 IBM WebSphere Process Server (Figure 2-3) is a business integration server. It is built to support solutions created based on service-oriented architecture (SOA). You can use it to build advanced business processes and traditional business integration such as enterprise application integration. WebSphere Process Server is based on WebSphere Application Server and best of the breed WebSphere Business Integration technologies. By building on top of WebSphere Application Server Network Deployment, WebSphere Process Server can take advantage of all the mature capabilities it provides, such as clustering, high availability, embedded messaging and transaction management.
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Supporting Services SOA Core



Business Business Processes Processes



Interface Maps



Human Human Tasks Tasks



Business Business State State Machines Machines



Business Business Rules Rules



Business Object Maps



Relationships



Selectors Selectors



Service Component Architecture



Business Objects



Common Event Infrastructure



Management // Administration Administration Management



Service Components



WebSphere Application Server (J2EE Runtime)



Foundation Figure 2-3 WebSphere Process Server architecture



WebSphere Process Server includes three layers:  SOA core  Supporting services  Service components



SOA core SOA core consists of Service Component Architecture (SCA), business objects, and the common event infrastructure (CEI).



Service Component Architecture (SCA) SCA is a unified service oriented programming model. SCA defines how one can abstract and represent a service without close coupling with the details of the implementation. It defines a simple unified client programming model, as well as defining how services can be composed together to form a solution. Service Component Architecture is a universal model for business services that publish or operate on business data. Service Data Objects (SDO) provides the universal model for business data. An SCA component is a component that runs on a SCA enabled run-time. An SCA component needs to specify its interface, implementation, as well as references (Figure 2-4).
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Reference: what this component calls



Interface: how to call this component



Component



Java



I



WSDL Port Type



Java



Interface



Reference



Java



R



Implementation



Process BPEL



State Machine



Business Rule



Human Task



WSDL Port Type



Selector



Implementation Types Figure 2-4 Service component



 SCA interface By definition, an interface is the place at which independent and often unrelated systems meet and communicate with each other. An interface can be defined by any programming/interface definition language. WebSphere Process Server currently supports a Java interface definition and an XML definition (WSDL port type). Arguments described in an XML Schema are exposed to programmers as SDO data objects. The WebSphere Integration Developer tooling primarily generates interfaces using the WSDL representation.  SCA implementation The SCA implementation specifies the implementation type of the component’s interface. Developers can implement business services in their language of choice (for example, Java, BPEL, or state machine). Current implementation types include business process, human task, interface map, selector, business rules, business state machine, and Java.  SCA references An SCA reference specifies other SCA services that a component uses. These can be softlinks, which do not have to specify which specific component will be used.
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Business objects Business objects provide an abstraction for data access and is an important concept for integrating applications and is used to interact within Service Component Architecture. Business objects provide rich features to map, manage and transform data to underlying IT and are described through standards based XML Schema (XSD).



Common event infrastructure (CEI) The common event infrastructure allows service component to emit events that can be captured by business monitors such as WebSphere Business Monitor for real-time monitoring of business processes. Common business events (CBE) is a common business event model that captures the basic business event information, such as the date/time an event is created, correlation IDs (relevant business events), IBM has also proposed CBE for consideration as a new standard to the Organization for the Advancement of Structured Information Standards (OASIS).



Supporting services On top of the runtime infrastructure and the SOA core, WebSphere Process Server offers a variety of service components. Supporting services are components that are needed in any integration solution including data transformation and synchronization services. Implementing the main features of WebSphere Enterprise Service Bus (ESB), a mediation component can be used to convert XML-based data formats. It can also be used to mediate between various transports, for example JMS and Web services. A mediation component contains a “message flow” that operates on a message including transformation, logging and filtering and custom Java operations. Above and beyond the ESB mediation component, WebSphere Process Server contains higher-level transformation capabilities.



Interface maps Interface maps let you invoke components by translating these calls. It is possible for interfaces of existing components to match semantically but not syntactically (for example, updateCustomer versus updateCustomerInDB2). This is especially true for components that already exist and services that need to be accessed. Additionally, you can use business objects to translate the actual business object parameters of a service invocation.
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Business object map A business object map lets you translate one type of business object into another type of business object. You can use these maps in a variety of ways, for example, in an interface map to convert one type of parameter data into another.



Relationship A relationship can be used to establish relationship instances between objects in disparate backend systems. You may want to access the same data within business integration scenarios, for example, customer records, or in various backend systems, such as an ERP system and a CRM system. A common problem for keeping business objects in sync is that different backend systems use different keys to represent the same object. These relationships are typically accessed from a business object map when translating one business object format into another.



Selector A selector can be used for dynamic selection and invocation of different services, which all share the same interface. For example a customer support process could use different human tasks implementations during holidays than during regular working days. WebSphere Process Server offers a Web-based interface to enable dynamic updates to the selection criteria and target services, which means that a module that has been deployed at a later time can still be called by this selector component enabling dynamic changes to the integration solution.



Service components WebSphere Process Server provides business processes, human tasks, business states machine and business rules service components.



Business process A business process component in WebSphere Process Server implements a Web services Business Process Execution Language (BPEL) compliant process engine. You can develop and deploy business processes that support long and short running business processes and a compensation model within a scalable infrastructure. You can create BPEL models in WebSphere Integration Developer or import from a business model that you can create in WebSphere Business Modeler.



Human tasks Human tasks are stand-alone components in WebSphere Process Server that you can use to assign work to employees or to invoke any other service. Additionally, the human task manager supports the ad hoc creation and tracking of tasks. You can use existing LDAP directories (as well as operating system



Chapter 2. Product overview



25



repositories and the WebSphere user registry) to access staff information. WebSphere Process Server also supports multi-level escalation for human tasks including e-mail notification and priority aging. WebSphere Process Server includes an extensible Web client that you can use to work with tasks or processes. This Web client is based on a set of reusable JavaServer™ Faces (JSF) components that you can use to create custom clients or embed human task functionality into other Web applications.



Business state machines Business state machines provide another way of modeling a business process. This lets you represent your company's business processes based on states and events, which sometimes are easier to model than a graph-oriented business process model. One example would be an ordering process where you can modify or cancel the order at any time during the order process until the order is actually fulfilled.



Business rules Business rules are a means of implementing and enforcing business policy through externalization of business function. This enables dynamic changes of a business process for a more responsive businesses environment. Business rule authoring is supported with Eclipse-based desktop tooling. Business analysts can use the Web-based runtime tooling included in WebSphere Process Server to update business rules as business needs dictate without affecting other services.



Imports and exports An import is a way of representing an external service in the SOA environment. For example, retrieving data from an ERP system can be turned into a service using the enterprise service discovery wizard. An export is the reverse, a way of representing an SOA service to an external service, such as a Web client. Note: WebSphere Process Server also includes support for business-to-business (B2B) scenarios by including the IBM WebSphere Partner Gateway.



More information For more information about WebSphere Process Server, refer to: http://www.ibm.com/software/integration/wps/
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WebSphere Business Monitor Version 6 WebSphere Business Monitor is a Web application that is deployed and run on WebSphere Process Server Version 6. It displays dashboards, which are containers (portals) that enable you to monitor different aspects of business performance. You can use the WebSphere Business Monitor to capture real-time, work-in-progress items and perform corrective actions by reassigning or suspending activities or processes. You can display real-time data from work items produced as the monitored process is running, and can also retrieve and view the historical data of the process. Dashboards serve a wide audience, essentially all line-of-business and systems management users in addition to business executives, enabling them to perform these tasks:  Monitor and manage business performance indicators  Retrieve information quickly and efficiently  Personalize the analysis and display of business performance reports, and compress information to focus on the business objectives and the key performance indicators (KPI)  View business-critical information graphically, using visual cues such as color to improve the probability of timely problem determination and the speed of decision making  Visualize performance data such as KPIs and metrics, which may be summarized in reports and graphs  Analyze and investigate business situations by using drill-down capabilities to trace situations to individual events and inspect event details  Set up actions and alerts that are part of the management phase of a business performance management solution Each dashboard is composed of one or several data snapshots, referred to as views. The dashboards run within the WebSphere Portal Server environment, and for each dashboard, a portal page is created and a set of views (portlets) are laid out in the portal page. The dashboard administrator can set up the following types of dashboard views in WebSphere Business Monitor:  Active instances—Display the values of all the business measures (KPIs, metrics, stopwatches, and counters) that you defined in the business measures model.  KPIs—Display the values of KPIs relative to their acceptable limits (below limits, within limits, or above limits).
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 Gauges—Display KPI values in the form of a gauge, like a speedometer or tachometer, relative to their acceptable limits or margins.  Scorecards—Monitor KPIs grouped by the scorecard perspectives that you select. By default, a scorecards view displays four perspectives: Financial, Customer, Learning and Growth, and Internal Business Process. Within each perspective, you can choose to monitor one or more KPIs.  Alerts—Display notifications that are sent when a business situation occurs.  Dimensions—Provide a multidimensional view of business performance data. You can pivot on any defined business dimension to analyze different aspects of the historical performance.  Reports—Display performance reports relative to a time axis. Such reports typically contain tables and graphs with textual descriptions summarizing the analysis.  Process diagrams—Display a process model with visual cues showing the status of each run of the process.  Organizations—Display the business organization units and their employees, in the form of a navigation tree. This information is stored on a user registry (such as LDAP) that WebSphere Portal is configured to use, and is not taken from WebSphere Business Modeler.  Export values—Enables you to export the values resulting from the running processes to an XML file that can be imported by WebSphere Business Modeler.



More information For more information about WebSphere Business Monitor, refer to: http://www.ibm.com/software/integration/wbimonitor/



Summary In this chapter we introduced the four products that are part of the IBM business process management solution. We will use the four products in our scenario to move a business process application from modeling to implementation to monitoring. The online Information Center documentation of the four product can be found at: http://publib.boulder.ibm.com/infocenter/dmndhelp/v6rxmx/index.jsp



28



Business Process Management: Modeling through Monitoring



3



Chapter 3.



Case study: ClipsAndTacks This chapter describes a business process management (BPM) scenario, that shows how a business can use a full IBM WebSphere Business Integration solution to complete the following end-to-end business process lifecycle tasks:  Model and simulate a business process.  Define key performance indicators.  Develop and test an application to implement the business process.  Deploy and run the application on a server.  Monitor the application to observe pre-determined key performance indicators.  Import the observed data to make required revisions to the original process model in the Modeler. The business scenario described in this document has been simplified in order to provide a full description of each stage of the BPM end-to-end process lifecycle. To avoid an overly large and unwieldy document, the authors' focus is on specific tasks, elements, and details, and not on presenting all possible facets of a complex business process. Each IBM software product included in the full BPM cycle has a large number of features and capabilities. For details on all of the available functions of these products, see the help documentation included with each product.
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Case study: ClipsAndTacks Office Supplies Ltd. This case study describes a fictional company that is seeking to improve one of its business processes. It shows how a business can quickly respond to the needs of its customers using an IBM business process management solution. The business described in this scenario, ClipsAndTacks Office Supplies Ltd. (abbreviated as ClipsAndTacks from now on) is experiencing a business problem that is negatively impacting its bottom line. The company needs to plan and implement a revised process that will address the business problem. To complete this business transformation, ClipsAndTacks will use the component products of IBM's business process management solution.



Background ClipsAndTacks is a medium-sized office supply company operating in eastern Canada and the northeastern United States. The company has grown slowly and has achieved a significant customer base through its excellent customer service practices and reputation for quality products. Most ClipsAndTacks customers are businesses; ClipsAndTacks does not allow accounts for non-business customers.



Business problem ClipsAndTacks has been losing customers to Office Market, its main competitor. Office Market is a national office supply chain which provides an online catalog and ordering process for its customers. From Office Market's Web portal, customers can view available products and submit an order 24 hours a day, 7 days a week. Although it has been losing customers, and consequently revenue, ClipsAndTacks' costs have remained constant relative to the order handling process. They have maintained the same number of customer representatives to avoid introducing further delays into the ordering process due to longer call-waiting times. Each customer representative traditionally receives an increase in their hourly wage each year. The company also continues to maintain separate customer and product management systems, neither of which have been upgraded in several years. Both systems are prone to problems and outages, and require considerable maintenance. Several customer surveys have indicated that ClipsAndTacks' customers are not satisfied with the ordering process. The telephone ordering procedure is time-consuming, and customers are frustrated at being placed on hold while waiting for the next available representative. Regular customers are frustrated at the amount of time it takes to receive their orders.
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The delays are most often caused by the order review process, requiring each order over $500 to be reviewed by an order manager for any credit risk before it is sent on to be filled. Customers repeatedly cite Office Market's online order process as a quicker and more convenient method for ordering their office supplies, and their comparatively quicker delivery time as a major advantage over ClipsAndTacks. Summary of problems:  Call center hours of operation are not convenient  Telephone order submission process is too long  Order review process delays shipments  Regular customers, in particular, resent delays due to order reviews  Company losing customers and revenue



Business objectives As a result of the customer surveys, ClipsAndTacks' management has decided that the order handling process has to be updated so that it can fill orders in a shorter amount of time. Company management wants to establish an automated process that shortens order turnaround time, especially for trusted repeat customers. The planned improvements include a new Web-based ordering system, which is a customer's access point to an almost totally automated ordering application. Simply put, it is an order handling application available 24 hours a day over the Internet. The high-level business objectives of ClipsAndTacks are to increase revenue and reduce costs. Note: Costs are currently not available for monitoring in WebSphere Business Monitor. We do not monitor and analyze costs in this document. Specifically, management wants to achieve the following objectives:  Reduce the average time from when orders are received to the time they are shipped to 3 days  Achieve an order approval rate of 90% or better
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Current order handling process ClipsAndTacks publishes a product catalog which is mailed to its existing account customers. Customers can only place orders by telephone, with calls routed through the company call center. The call center is staffed by customer representatives and takes calls between the hours of 8:00 a.m. and 5:00 p.m. Eastern Time, Monday to Friday. For new customers, a customer service representative manually enters the contact and address information to the customer database and assigns a customer number. Existing customers have to provide their customer number so that the representative can retrieve the customer record containing the customer's information. When the customer information is retrieved, the customer provides the details of the order. All orders are forwarded to an order manager. If an order total is $500 or more, the order manager must review it before sending it to the warehouse to be filled. The order manager assesses the credit risk of each order: if the order is deemed an acceptable risk, it is sent on to the warehouse to be filled; if it is not deemed an acceptable risk, the order manager cancels the order and sends an e-mail notification to the customer. All approved orders are sent to the warehouse to be filled. Summary of business rules:  Customers can only order by telephone  Orders are accepted only from 8:00 a.m. to 5:00 p.m. Eastern Time, Monday to Friday  Customer service representatives handle all inbound order requests  All orders are forwarded to the order manager for review  Orders over $500 must be approved by the order manager



Planned revisions to the order handling process ClipsAndTacks' management wants to implement an order submission process that will allow ClipsAndTacks to compete with Office Market. In response to a common complaint in the customer surveys, the new process will eliminate the need for contact between customers and customer service representatives when an order is placed. Customers will be able to browse the ClipsAndTacks product catalog and enter their own order information using a Web application. New customers will be able to enter their company information and receive a customer account number immediately.
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Customers who have a customer number will be able to enter it and prompt the Web application to retrieve their information and pre-fill the Web form with their address and preferred shipping information. The new Web application, including the product catalog and order form, will be available 24 hours a day, 7 days a week. When the customer submits the order, a business rules engine will be checked to ensure appropriate action on the order. In response to comments from regular customers, the threshold for order review will be raised to $750. If an order is for an amount under $750, it is approved automatically, pending a check of the account status (that is, are there any outstanding charges against the account that have not been paid). If the account is in good standing, the order is sent for shipping. If the account is not in good standing, it is sent to an order manager for review. If an order is for an amount greater than $750, it is sent for to an order manager for review. Based on the review, the order manager decides whether to send the order for fulfilment or to cancel the order and notify the customer. Summary of revisions:  Customers can order online (shorten order process)  Orders are accepted 24 hours a day, 7 days a week  Implementation of rules/policy engine  Threshold for order review has been raised to $750  Orders over $750 must be approved by the order manager (shorten average order time and increase percentage of approved orders). Note: We will have to reiterate that we are presenting a simplified process. The outright cancellation of an order is less likely than a request for prepayment, or some other arrangement between the companies. A simplified scenario is presented in order to show details of each phase of the full cycle.



Key performance indicators Key performance indicators (KPI) are the detailed specifications required to track business objectives. Each KPI is associated with a specific process, and is quantifiable, measurable, and results-oriented. The ClipsAndTacks management team wants to be able to measure the results of the revised process when it is implemented to ensure that it is helping to meet the company's business objectives. To measure the revised order handling process, management has identified two key performance indicators that will measure the success of the new process. Each of these key performance indicators will comprise at least one metric.
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To gauge the performance of the revised process and determine if it helping to achieve the company's business goals, the ClipsAndTacks management team will set the following KPIs:  Average order fulfilment time is 3 days or less: – Target: 3 days – Lower margin: 1 day – Upper margin: 3 days Required business measures elements: – Order Fulfillment Timer stopwatch – New Order Trigger – Ship Order to Customer Trigger  Number of approved orders is greater than 90% – Target: 90% – Lower target margin (%): 85.5% – Upper target margin (%): 90% Required business measures elements: – – – – – –



Total Orders aggregate metric Shipped Orders aggregate metric Order Counter Shipped Order Counter New Order Trigger (reuse) Ship Order to Customer Trigger (reuse)



Roles The following key roles take part in the ClipsAndTacks BPM scenario:  Customer Typically, ClipsAndTacks customers are business professionals who purchases office supplies for a company. Customers are comfortable with Web processes, and expect an order process to be quick and simple. They also expect that orders will be delivered promptly.  Business analyst ClipsAndTacks employs a business analyst on staff. The business analyst is responsible for understanding the company's existing processes and designing ways to improve those processes. The analyst gathers and documents information about the company's processes by reviewing reports, interviewing employees, and observing performance. The analyst then models and simulates current and planned practices.
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The business analyst also defines the business measures, such as the key performance indicators, that will be monitored. In our scenario the business analyst uses WebSphere Business Modeler to model, simulate, and analyze the business process.  Order manager (order approver) A ClipsAndTacks staff member who has the authority to accept or reject a purchase order. Orders that are over the limit of $750 are routed to the order manager, who either approves or declines the order. ClipsAndTacks management provides guidelines to the order manager that help making the decision.  System architect (integration developer) The system architect is responsible for designing, building, and testing the implementation of the revised process that has been modeled by the business analyst. In our scenario the architect uses WebSphere Integration Developer to implement the business process and WebSphere Process Server to test the implementation.  Application programmer The application programmer is responsible for implementing some of the specific services that the systems architect has specified at a higher level. For example, the programmer writes the Web application to be used by the customers, and the Java code to interface with external services.  System administrator The system administrator is responsible for deploying the finished application in a production environment using WebSphere Process Server and for monitoring the runtime process using WebSphere Business Monitor. The administrator ensures that the component programs operate as they are designed. The administrator records relevant data about the process and produces performance reports for company management. Throughout this redbook, key roles will be described for each stage in the process.



Subsystems Figure 3-1 shows the abstract logical subsystems that comprise the solution architecture. The essential subsystems for the ordering process are shown in green with a bold border.
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Figure 3-1 Solution architecture



Table 3-1 describes the essential subsystems. Table 3-1 Abstract logical subsystems that comprise the solution architecture
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Subsystem



Description



Product Search UI



Web-based user interface for customers to search and/or select products from an integrated product catalog.



Order UI



Web-based user interface for customers to enter order information, such as quantity and shipping method, or to view the details of existing orders.



Order Approval UI



User interface for the order approver to view and authorize orders.



Configuration UI



User interface for ClipsAndTacks' staff to configure the ordering process, specifically, the order approval process.
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Subsystem



Description



Performance Dashboard



Web-based user interface for Business Performance Analyst to query and view business performance results



Order Handling Service



A business process that responds to the Order UI and creates new orders or displays existing order status. The process determines whether an order can be automatically processed according to the procurement policies.



Order Approval Service



A workflow process that is used by the order approval staff to validate and approve orders.



A n



Hardware prerequisites You must have installed and configured the full BPM suite of products before completing the set of tasks described in this redbook. See the individual product documentation for installation and configuration instructions. System hardware requirements are shown in Table 3-2. Table 3-2 Hardware requirements WebSphere Business Modeler Processor



Pentium® III 500 MHz (or equivalent) or faster



RAM



768 MB (1 GB recommended)



Disk Space



500 MB to install



Display



Minimum 1024 by 768 resolution



WebSphere Integration Developer Processor



Pentium IV 1 GHz (or equivalent) or faster (2.5 GHz recommended)



RAM



1 GB (1.5 to 2GB recommended)



Disk Space



4 GB to install



Display



Minimum 1024 by 768 resolution



WebSphere Process Server Processor



Pentium IV 1 GHz (or equivalent) or faster



RAM



1 GB



Disk Space



2 GB to install
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Display



Minimum 1024 by 768 resolution



WebSphere Business Monitor Processor



Pentium IV 1 GHz (or equivalent) or faster



RAM



1 GB



Disk Space



2 GB to install



Display



Minimum 1024 by 768 resolution



More information For more information about system requirements, refer to these Web sites:  WebSphere Business Modeler: http://www.ibm.com/software/integration/wbimodeler/advanced/sysreq/



 WebSphere Integration Developer: http://www.ibm.com/software/integration/wid/sysreqs/



 WebSphere Process Server: http://www.ibm.com/software/integration/wps/sysreqs/



 WebSphere Business Monitor: http://www.ibm.com/software/integration/wbimonitor/requirements/



Summary In this chapter we introduced the ClipsAndTacks company. We will use their order handling business process to demonstrate how the IBM business process management products can be used to model, implement, run, and monitor the ClipsAndTacks application.
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Part 2



Part



2



Modeling the business In Part 2 we describe the modeling activities to be carried out by the ClipsAndTacks business analyst. We start with the model of the current business, Order Handling (Current), and simulate its behavior to find out the bottleneck. Then we describe how to improve the model to provide for a better customer response time and for more orders approved. This model is referred to as Order Handling (Future 1). We simulate and analyze the new model. Finally we decide what business measures to define and what key performance indicators (KPI) to measure when we implement the new model in WebSphere Process Server and monitor the execution using WebSphere Business Monitor.



© Copyright IBM Corp. 2006. All rights reserved.
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4



Chapter 4.



Modeling the current business process This chapter describes how the ClipsAndTacks order handling process, Order Handling (Current), was modeled and imported into WebSphere Business Modeler. The key to a successful re-engineering of a business process is to thoroughly understand the details of the existing process and to accurately forecast the results of the changes to that process. In order to analyze and predict the outcome of a revised process, a business first needs to create an accurate representation of the process with a model and then study how that process performs under different conditions. A common error that businesses often make when they set out to revise their processes is failing to fully investigate and understand their current process and their objectives in re-engineering that process. Without devoting the necessary time to study, analyze, and plan, many businesses find that either they have not adequately addressed the original problem, or they have simply exchanged a recognized problem for another unanticipated one.



© Copyright IBM Corp. 2006. All rights reserved.
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Introduction to modeling the current business process Before implementing a revised order handling process, the company must fully document, model, and analyze the current process so that it can fully understand where the business problems lie and set realistic targets for the process improvement. At ClipsAndTacks, the lead business analyst has been given the task of designing the revised order handling process. On its surface, this step seems fairly straightforward. To ensure that his model is as accurate as possible, The business analyst must first document and sketch the current process flow, and list all of the key resources (people, equipment, material), business items (documents, records, products), and business rules (decision logic) included in the process. Note: For detailed instructions on how to create each of the elements described in following sections, refer to the help documentation included with WebSphere Business Modeler.



Documenting the current process For the remaining of this chapter, you are now the business analyst. The first step is to investigate and fully document the current process. By reviewing available data reports and interviewing each employee involved in the process, you can gain an understanding of how the process currently works, and where the problem areas lie. For ClipsAndTacks, you must monitor each stage of the process, observing the employees' interaction with customers, and the progress of orders through the complete order handling process. You have to focus on recording all key aspects of the process:  What is the process flow?  What are the resources used in the process?  What are the business items acted on by the process? As you study the process and gather your data, record the following:     
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Activity inputs and outputs Task variations and when those variations occur Alternative tasks Complete task descriptions Roles associated with tasks
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After you have gathered sufficient data, record the findings and map out a rough flow diagram of the current process. Make note of the output at each stage of the process, indicating stages where there is more than one possible outcome. List all of the activities, resources, roles, and business items involved in the process.



Process flow When you have gathered all available data and observed the current process in action, you will be able to write out the process flow, including any spot where there is more than one possible outcome. At ClipsAndTacks, the current order handling process flow takes place as follows: 1. The customer service representative receives the call from the customer. 2. First determine if the customer has an account. 2.1 If the customer has an existing account: – Enter the account number. – Enter the order information. – Approve order or send for review. 2.2. If the customer does not have an account: – Enter customer information and assign an account number. – Enter the order information. – Approve order or send for review. 3. If the order is approved: – – – –



Send the order to the warehouse. Record order in order records database. Issue packing slip. Ship the product.



4. If the order is sent for review: – Review the order manually. – Determine if the order is an acceptable credit risk. 4.1 If the order is an acceptable credit risk: – – – –



Send the order to the warehouse. Record order in order records database. Issue packing slip. Ship the product.



4.2 If the order is not an acceptable credit risk: – Cancel the order. – Send an order cancellation notification to a customer.
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At this stage, you have enough information to sketch out the process. You can use WebSphere Business Modeler to sketch out the rough process, or simply draw it using pencil and paper. The process flow for the Order Handling process might look as shown in Figure 4-1.



Figure 4-1 Manual process flow draft



Business items Review the flow to determine the business items that are acted on during the process. Remember that business items are business documents, work products, or commodities that are transformed in business operations. You can model as a business item anything that is created, assembled, inspected, tested, modified, or worked upon. Business items undergo changes as they are passed from one process step to the next. For the ClipsAndTacks order handling items, the following business items are acted on in the current order handling process:  Request (a verbal request from the customer)  Order (a list of products requested by the customer with the shipping and billing information)  Customer record  Packing slip with packaged product  Cancellation notification to a customer
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Resources A key to documenting any process is determining the resources and roles required to complete each of the activities. Resources represent the people, equipment, or material used to perform a project or a task. Resources are not the same as business items. The objects that undergo changes and are passed from one process step to the next should be modeled as business items, whereas the things that are performing the work or are required prerequisites for this work, such as machines, fuel, vehicles, or skilled personnel, should be modeled as resources. Resources are represented by the following people roles and subsystems in the ClipsAndTacks order handling process:      



Customer service representative Order manager Shipper Customer records system Product catalog system Order management system



Timetables An accurate model must also take into account the schedules of the resources involved in the process. In WebSphere Business Modeler, you can define timetables that specify what times certain resources are available. The following timetables are required to indicate the work hours of the key roles in the current order handling process:  Day shift  Weekend



Creating the current process diagram using the Modeler In this section we describe how to create the model of the current process flow.



Detailed steps to create the model Business modeling is an iterative process, requiring the business analyst to continually revise the process as he or she gains a deeper understanding of the goals, requirements, and individual activities involved. The business analyst must continue to meet with subject-matter experts to gather information and validate draft models.
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The current order handling process diagram reflects the current process flow as you have documented it. Because this redbook is not focused on just the modeling of the process, but instead it has the goal of documenting the complete end-to-end business process management lifecycle, we will not go through each step of creating a current process model in this chapter. The detailed documentation on how to use Modeler is available in the help documentation included with the product. In Chapter 6, “Modeling the Future 1 business process” on page 83, we will go through the detailed steps for modifying an existing process model. In this chapter we import the current order handling process model that was previously built by the business analyst.



Modeler quick guide This redbook is not a complete guide to WebSphere Business Modeler V6. However, we provide here a few simple guidelines for working with the Modeler. Start the Modeler using Start → Programs → WebSphere Business Modeler → WebSphere Business Modeler.



Perspectives You most often work in the Business Modeling perspective. You may also use the Resource perspective to see the underlying physical files.



Modeling mode The Modeler supports a number of modes that provide more details and capabilities:      



Basic—Focus on purely business tasks Intermediate—Adds input and output details and formal expressions Advanced—Models that form the basis of software applications WebSphere Business Integration Server Foundation WebSphere MQ Workflow WebSphere Process Server



The first three modes are for modeling the processes, business items, resources, organization, and so forth. The last three modes enable you to define details that will be used when the processes are exported for usage in one of the three products.
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For our scenario we work using the Advanced mode for modeling, and the WebSphere Process Server mode before exporting to Integration Developer and process Server. The mode is set by selecting Modeling → Mode → Advanced (for example).



Help and tutorial The Modeler provides extensive help. Select Help → Help Contents to open the help facility. If you are a beginner, expand WebSphere Business Modeler Advanced and select Samples and tutorials → Tutorial: Quickstart. Then go through the complete tutorial to become familiar with the Modeler.



Screen layout Click the Apply 4-pane layout icon to see the Project Tree, and edit area, the Outline, and Attributes/Errors. This layout gives you access to all important tasks.



Importing the current process model using the Modeler Listed below are the detailed steps for the importing of the existing process model that was previously built using the Modeler product. You can import models or definitions from several different formats into the WebSphere Business Modeler Version 6. Specifically, you can import files in the following formats:          



Business Integration Modeler project (.zip) WebSphere MQ Workflow (.fdl) WebSphere Business Integration Workbench 4.2.4 (.org) Delimited text files (.csv, .txt) XML Schema Definition (.xsd) Microsoft® Visio® (.vdx) WebSphere Business Integration Modeler XML (.xml) Monitoring result (.xml) CEI Event Catalog Web Service Interface (.wsdl)



We import the current order handling process model that was previously modeled and exported as a WebSphere Business Modeler project zip file. The Business Integration Modeler project ZIP file can be found in the sample code available with this redbook (see Appendix C, “Additional material” on page 439): SG247148\sampcode\model\ClipsAndTacks Chapter 4 Solution.zip
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To import the ZIP file, complete the following steps:  In the Project Tree, right-click and select Import. The Import wizard appears.  Select WebSphere Business Modeler project and click Next (Figure 4-2).



Figure 4-2 Select model import type



 Click Browse to select the source directory that contains the file you want to import (Figure 4-3).



Figure 4-3 Importing a model
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 In the Files list, select the ZIP file containing the project or element that you want to import. Select the Clips And Tacks Chapter 4 Solution.zip file.  Select Include simulation snapshots and Include business measures.  Optionally select Overwrite existing elements to replace any of the elements with the same name as an element being imported. Otherwise, you will be warned when an element is about to be overwritten. Note: If you choose to overwrite a catalog, be aware that the entire catalog and all of its contents will be deleted and the contents of the new catalog will be imported instead.  In the Target project field, select an existing project from the drop-down list or click New to create a new project Clips And Tacks Chapter 4 Solution (Figure 4-4).



Figure 4-4 Creating a new project ClipsAndTacks



 Click Next. Select the default Free-Form Layout, then click Finish.  The project is created and its named filled into the dialog. Click Finish to import the ZIP file.  If there are any errors or warnings during the import process, click Details to read them. The project files have been imported into the project you specified. The Project Tree view of the project is shown in Figure 4-5.
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Project tree filters: deselect Definition templates to see Customer Information and Product Information



Open the process



Figure 4-5 Project Tree of the order handling process



Order Handling (Current) process The imported current order handling process model is shown in Figure 4-6.



Figure 4-6 Current order handling process model (compressed to fit)
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The activities in the order handling process are:  Receive Order—A local process that handles the interaction of the customer with an agent.  Review Order—An order manager reviews all orders over $500 and decides if the order should be approved or declined.  Ship Order to Customer—If the credit risk is acceptable the order is processed, recorded in an order database, and shipped.  Cancel Order and Send Notification—If the order is declined a cancellation notification is sent to the customer. The last three activities are so called human tasks, performed by a person. The input to the process is a customer request, and the output is the product shipment. The default probability for each branch of Acceptable Credit Risk is 50%.



Embedded process To view the embedded process, Receive Order, select the process and Edit (context menu). The sequence of the Receive Order process is shown in Figure 4-7.



Figure 4-7 Receive Order subprocess (compressed) To go back to the order handling process, right-click in an empty space in the diagram and select Parent (context menu).
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Business items The business items that used during the process are listed here:  Order—The Order is the main business item that flows through the whole process (Figure 4-8). An order consists of an OrderNumber, an OrderStatus, the TotalPrice of the order, a Customer with all its information, the OrderItems (which products), and a processing field (automaticApproval coming from Order Processing Data).



1 or many items



Figure 4-8 Business item: Order



 Customer Record—The data kept for a customer is composed of basic data coming from Customer Information and additional attributes, Classification, Rating, and AvailableCredit (Figure 4-9).



Customer Information



Figure 4-9 Business Item: Customer Record
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 Order Item—An order item consists of a Quantity of a product ordered. The product attributes come from Product Information (Figure 4-10).



Product Information



Figure 4-10 Business item: Order Item and Product Information



 Product Shipment—Similar to the order, consist of a Packing Slip Number, OrderNumber, TotalPrice, Customer, and OrderItems.  Notification—Consists of the email address and the text to be sent to a customer when an order is declined.  Request—This is the request coming from a customer to order some products. The business items Customer Record, Order, and Order Item will be used for the database design when we implement the application in a WebSphere server. Note: These Customer Record business item already includes some fields that will only be used later in our scenario (Classification and Rating).



Description of some business item attributes Most of the attributes are self-explanatory, the others are explained here:  OrderStatus—The status of an order during the process: NEW, APPROVED, DECLINED, SHIPPED.  automaticApproval—An order can be automatically approved if the total price is below a certain value. This attribute is either false or true.  Classification—later in our scenario customers are classified as REGULAR, SILVER, or GOLD. The total price for automatic approval will depend on this classification.  Rating—The credit rating of a customer as retrieved from an external service. This value will be used by the order manager to decide if an order should be approved or declined.  AvailableCredit—The available credit of a customer. This value will be used by the order manager to decide if an order should be approved or declined.
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Resources The resources defined for our scenario are:  Customer service representative—Takes the phone call from a customer.  Order manager—Decides if an order should be approved or declined.  Shipper—Package the products and ship to the customer.  Customer Records System, Order Management System, Product Catalog System—Computer applications used for customer information, orders, and the product catalog.  Day Shift and Weekend—Time tables.



Organizations and classifiers No organizations and classifiers have been defined for our scenario.



Summary In this chapter we described how ClipsAndTacks modeled their current business to get a better understanding of the business process, the activities, and to prepare for simulation and analysis.
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Chapter 5.



Simulating and analyzing the current process This chapter describes how the ClipsAndTacks current process is simulated and analyzed in the Modeler. The key to a successful simulation and analyzing of the current process is to describe correctly what information we should gather from the real world business process to simulate a process. The first part of this chapter provides an example of a set of information required to implement a representative simulation and analysis. The second part of this chapter shows a demonstration on how to gather and analyze information provided by the simulator of WebSphere Business Modeler.



© Copyright IBM Corp. 2006. All rights reserved.
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Overview of process simulation These are the major steps to run a simulation of a process:  Define resources and probabilities: – – – – – – –



Corporate strategies Process flow Human resources needs and costs matrix Duration matrix Human resource availability matrix Probabilities on decision matrix Probabilities on output matrix



 Define a simulation profile and attributes related to the simulation runs  Enter all simulation attributes in the Modeler  Run a simulation snapshot  Analyze simulation results



ClipsAndTacks process assessment for the simulation After modeling the business process, you can use WebSphere Business Modeler to simulate the running of the process. Simulating allows you to assess the performance of the process, generate statistics about its execution, and pinpoint potential areas of improvement. A process simulation is a simulated performance of a real world business process in a virtual environment. Before simulating the current process, the lead business analyst in charge of this project must organize workshops with operational officers to gather the following information about the real wold business process:  The corporate strategy, also called business objectives, is described in Chapter 3, “Case study: ClipsAndTacks” on page 29.  The documentation and the design of the processes are described Chapter 4, “Modeling the current business process” on page 41. As a result of these workshops a number of documents are produced.



Role resources matrix The role resources matrix (Figure 5-1) shows the number of people for a specific role and resources assigned to activities. This matrix also shows the cost by roles. Usually the cost is defined by the salary divided by the unit of measure, an hour in our case.
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Resources / Activity



Costs USD per hour



Customer Service Representative



11.00



Order Manager



20.00



Shipper



10.00



Order Management System



0.00



Customer Records System



0.00



Determine if Customer has Existing Account



Enter Customer Information and Assign Account Number



Enter Account Number



Enter Order Information



Review Order



Cancel Order and Send Notification



Ship Order to Customer



Figure 5-1 Roles matrix: Cost and resource/role per activity



Duration matrix The duration matrix (Figure 5-2) shows the duration of human tasks for a specific role and a specific activity. In this example, there is only one role per activity, but there could be multiple human roles for one activity. Be careful, the total duration is not equal to the sum of the resources durations, because some resources are used in parallel.



Activity duration



Determine if Customer has Existing Account



Enter Customer Information and Assign Account Number



Enter Account Number



Enter Order Information



Review Order



Cancel Order and Send Notification



Ship Order to Customer



20 sec



6 min



20 sec



12 min



20 min



2 min



16 min



20 sec



5 min 45 sec



10 sec



12 min 20 min



2 min



Resources / Activity Customer Service Representative Order Manager Shipper



15 min



Order Management System Customer Records System



1 min 10 sec



15 sec



5 sec



2 min



1 min



1 min



Figure 5-2 Duration matrix: Duration of activity by role and resources
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Availability matrix The human resources availability matrix (Figure 5-3) shows the timetables assigned to human roles. In our business case, only one timetable named Day Shift is used (described as a resource in the Modeler). The day shift is defined as:  9 working hours a day  Working days are Monday to Friday  Working hours 8:00 AM to 5:00 PM



Timetable / Resources



Customer Service Representative



Order Manager



Shipper



Order Management System



Customer Records System



Day Shift



Figure 5-3 Availability matrix: Time table per role



Note: the Weekend timetable is used as an exemption for the day shift timetable.



Decision probabilities One of the process model components is a decision. You can assign a probability on decision choices (for example: is a customer an existing customer?), which determines the method of selecting a path through the process.



Decision / Probability



Yes



No



Acceptable Risk Credit



70%



30%



Existing Account



50%



50%



Figure 5-4 Decision matrix: Probability (yes/no) per decision



Note: WebSphere Business Modeler allows to define probabilities on output criteria, which are the allowable combinations of outputs for an activity. In our case, you could find an example of multiple outputs with a probability defined in the activity “Ship Order to Customer”.
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Simulation profile information The assessment of the current process provides information about the duration of the benchmark to reflect a representative simulation. For our scenario, we define:  The number of tokens for the simulation: 270 – A token represents a unit of work that is received by a process and transferred between different activities in the process flow. By specifying token creation settings, you define the quantity and rate of inputs that the process handles in a simulation run. For our example, a token represents a request. Assuming that we get 30 requests per hour, there will be 270 requests per 9 hour day.  The maximum duration of the benchmark: 365 days – Specify the maximum duration that a simulation will run. The maximum duration is the real time during which the simulation occurs.  The start date and time of the simulation: Monday, October 24, 2005 08:00:00 AM – Specify start and end dates and times to define the virtual time in which the simulation takes place.  The time measurement unit for results: Minutes – Select a unit of time that will be used for defining time-related distributions and for recording the results of process simulations.  The distribution model for requests: uniform distribution by minutes – Measurements using any variable, even the same variable on the same subject, result in different outcomes. The pattern of different outcomes is called the distribution, which can be described mathematically and graphically. The distribution describes the relative number of times each possible outcome will occur in a number of trials. Note: For more information about distribution models, refer to the product documentation: Simulation processes → Setting Simulation → Attributes → Specifying token creation settings  Steady delay for the process: 0 minute – Specify a period which must elapse in the virtual time of a simulation run before statistics gathering begins.
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 Method of selecting an output path: Base on probabilities – Select a method that the process simulator will use to determine which processing path to follow when a process or an activity in a process has more than one set of outputs defined by output criteria.  Recurring time interval for bundle creation: 2 Minutes (270 in 9 hours)



Populate the simulation environment Simulation attributes allow you to configure a process so that it behaves in a manner that resembles a real world business process. A simulation environment is divided on four layers:  The global simulation preferences (select Windows® → Preferences → Business modeling → Simulation) hold the default values for the local preferences of any newly created simulation snapshot.  The local simulation (process default element) preferences are applied as default values for the simulation attributes of any new simulation profiles that you create for the current snapshot.  The top-level process simulation attributes (process snapshot element) where you define the behavior of a process as a whole during a simulation. �� The low-level activity simulation attributes (process element or process snapshot element) where you define the behavior of an activity in a simulation. Note: For more information about simulation level and informations, refer to the product documentation under Simulating Processes. With all information acquired, the first task is to assign a timetable and cost elements to the human role resources. Note: You can import the model populated with simulation information from: SG247148\sampcode\model\Clips And Tacks Chapter 5 Solution.zip



See “Importing the current process model using the Modeler” on page 47 for instructions on how to import a model.
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Populate role resource information in the project Roles add additional characteristics to resources. For example, an Employee resource could have the role of Customer Service Representative, Order manager, or Shipper. You can specify the roles that are required to complete any task that you model. You can add costs and availability to roles. For example, a certain role may cost $20 an hour and be available only from Monday to Friday.



Customer service representative In the Project Tree (Figure 5-5), navigate to the Resources and open the role that you want to modify (you have to insert data for the three resources).



Figure 5-5 Open a resources role



In the Customer Service Representative editor area (Figure 5-6), insert the cost following this sequence of action:  Select the Costs tab and click Add.  Select Cost per time unit and click OK. The Cost per unit time appears in the list.  Enter the cost value (11.00 USD for the Customer Service Representative).  Click Edit to update the time unit, select 1 hour, and click OK.  Save the changes.
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Figure 5-6 Role resource costs



In the Customer Service Representative editor insert the duration (Figure 5-7):  Select the Availability tab, and click Add.  Select Day Shift, and click OK.  Save the changes.



Figure 5-7 Role resource availability



Order Manager and Shipper Perform the same operation for the Order Manager and Shipper roles and set the cost to $20 and $10, and the availability to Day Shift.
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Populate duration information in the process You can specify the processing time for an element such as a task or process. This is the time while the element is actively executing, rather than the elapsed time, which may include delays while waiting for a resource. For a task, you can also specify the maximum amount of time that the task should wait for a resource before failing. In our case we will assign two types of duration information, one for the activity and one for the human tasks (role resource). To be able to select individual activities, open the process diagram for the Order Handling (Current) process. In the process flow select the activity, and in the Attributes view, select the Duration tab and enter the duration value (Figure 5-8).



Figure 5-8 Activity duration



To populate the resource (human task) duration time (Figure 5-9):    



Select the activity in the model, for example, Review Order. Select the Resources tab in the Attributes view. Click Add to add a role. Click in the Role column to select the role, for example, Order Manager.
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 Click in the Time required column and select the duration time, for example, 10 minutes.  Save the changes.



Figure 5-9 Activity role duration



The activity duration can have an overhead time on top of the human role duration time (this is the case for the Enter Account Number activity). Important: in this example, you define duration times in the original flow, which is the master for the simulation snapshots. It is possible to change those values for each simulation without changing data in the original flow. This particularity enables you to run multiple simulations without alteration of the original values that reflect the real world business process.



Validate the simulation data You can validate in WebSphere Business Modeler if you have populated all the required information. Select the project and Static Analysis → General Analysis → Matrix Analysis (context). This function displays the roles by activities (Figure 5-10):  Select Activity for rows, Role for columns, and click Next.  Select Processes, select the process you want to analyze, and click Finish.
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Figure 5-10 Static analysis: Activity versus role



Tip: After you create the simulation snapshot, you will be able to validate your process elements including durations, probabilities, and costs. See “Verify the profile specification” on page 71 for more information.



Populate probability information in the decision nodes You can add a probability to each branch of a decision to indicate the probability of that branch. The probability for each branch is set to 50% when the first two branches are created. You change original probabilities in the process to reflect the real world business process. In the process flow, select the Acceptable Credit Risk activity in the process flow. In the Attributes view, Output branches tab, set the probability values for the Yes and No branches (Figure 5-11). Note that you can also overtype the values in the process diagram.
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Figure 5-11 Decision activity probability



Populate probability information in activity nodes If you have more than one output criterion, you can optionally add probabilities to indicate how often each of the criteria occurs. For example, you could specify 60% for the more likely output and 40% for the less likely output. If you specify a probability for one output criterion, you must specify probabilities for all. If you do not specify probabilities, each output criterion is considered equally likely when you create a simulation snapshot. For example, select the Ship Order to Customer activity in the process flow. In the Attributes view, Output Logic tab, you can see the three outputs as equal (Figure 5-12). To assign probabilities you would have to add rows and enter a probability for each output. In our model we do not assign probabilities to the output of activity nodes.



Figure 5-12 Activity output logic probability



Once you have populated every real world business process value in the simulation environment you are ready to create a simulation snapshot. A snapshot reflects the real world simulation including your assumptions.
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Simulating the current process In this section we simulate the current process and analyze the results.



Process instance simulation Before running the simulation on your process, it is necessary to build a simulation snapshot and add information to get an accurate simulation. The simulation information includes:         



The number of tokens for the simulation: 270 (one day) The maximum duration of the benchmark: 365 days The start time of the simulation: Monday, October 24, 2005 08:00:00 AM The time measurement unit for results: Minutes The distribution model: uniform distribution by minutes The random number seed: 1 The steady delay for the process: 0 minute The method of selecting an output path: Base on probabilities The recurring time interval for token creation: 2 Minutes (270 a day)



Creating a simulation snapshot When you simulate a process, the tool adds a simulation snapshot as a child element of the process in the project tree. A simulation snapshot is a record of the complete process model at the moment when you simulated the process. This record contains a copy of all the elements of your project that the process may use, such as business items, resources, and global tasks. You may want to create multiple simulation snapshots for the same process after making changes to the project or to the process itself, so that you can compare the effect of these changes. To create a simulation snapshot, select the Order handling (Current) process and Simulate (Figure 5-13).
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Figure 5-13 Creating the simulation snapshot for a process



Within the simulation snapshot, the tool also creates tho folders:  Defaults—The defaults folder contains a set of local preferences for simulation attributes. When you create a new simulation profile for a simulation snapshot, the values specified in the local preferences are used for the simulation attributes of the process and activities within the process. The initial values of the local preferences are inherited from the global simulation preferences (Windows → Preferences → Business Modeling → Simulation).  Profile—Each simulation snapshot contains an initial simulation profile. The simulation profile contains a copy of the process model at the time that you created the simulation snapshot. You can customize the process contained in this simulation profile, and you can create additional simulation profiles within the same simulation snapshot. Typically, you would create multiple simulation profiles for a simulation snapshot when you are experimenting with changes to the fields in the simulation profile, to determine the effect on process results. After you create snapshot you have to populate the system with your simulation data. The simulation profile diagram opens.



Simulation snapshot defaults Open the Order Handling (Current) Defaults and specify the values for your simulation as shown in Figure 5-14.  In the General tab select: – Resource always available: False – Disable resource allocation: False – Use resource time: True
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 In the Token tab select: – Total number of tokens: 270 – Random time trigger: Uniform distribution and Minutes – Recurring time interval for bundle creation: 2 minutes



Figure 5-14 Process simulation default profile



Simulation snapshot process profile The simulation profile should be open (after creation), but you can also open it from the Project Tree. Important: To run and display a simulation properly, you have to set your computer time zone before a simulation. Your time zone should be equal to time zone used in the project (except for specific reason). In the current project every element’s time zone (timetable, simulation attributes) is defined as (GMT -5) Eastern Time. If you change your computer time zone you have to restart the WebSphere Business Modeler.  Populate the General tab (Figure 5-15): – – – – – –



Starting date (GMT-5), and ending date (GMT-5) Evaluate all subprocesses: Yes Time measurement unit: Minutes Maximum simulation duration: 365 days Random number seed: 1 Delay of steady state simulation: 0 second
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– Method of selecting an output path: Based on probabilities – Resources’ time required: Yes



Figure 5-15 Simulation profile: General



 Populate the Inputs tab with the number of tokens, the start time, and interval (Figure 5-16):



Figure 5-16 Simulation profile: Inputs
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– – – –



Total number of tokens: 270 Select the Time trigger Start time: same as the process starting date and time zone Recurring time interval: 2 minutes



 Finally, populate the number of human resource available in the Resource pool tab (Figure 5-17): For each role resource (Customer Service Representative, Order Manager, Shipper), deselect Unlimited and enter 1 in the quantity box.



Figure 5-17 Simulation profile: Resource pool



Verify the profile specification You can verify the profile specification by selecting the Order Handling (Current) Profile and Profile Analysis → Profile Specification. Select all processes when prompted. The profile specification (Figure 5-18) lists all the processes with the resources that are used and the duration of each resource. Note: You can also see the simulation attributes in the Simulation Attributes tab of the process (behind the Diagram tab).
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Figure 5-18 Profile analysis: Processes with resource sand duration



Running the simulation We are now ready to run the simulation. Open the Simulation Control Panel view (Figure 5-19) behind the Attributes area, and click the green arrow icon to start the simulation.



Figure 5-19 Simulation control panel
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The system shows the token moving in the flow and the list of process instances (Figure 5-20). At this point, you might pause , stop , or step through the simulation.



number of instance in process



current token current simulation summary



Figure 5-20 Current process simulation running



Tip: You can run the simulation faster without animating the simulation (Figure 5-21).



Figure 5-21 Simulation settings
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Analyzing the simulation results (Current) Once the simulation is complete, you can now use the dynamic analysis function on the simulation result element (Figure 5-22).



Figure 5-22 Simulation result element



For the current case, the business analyst needs four categories of the process:    



Process duration Process cases summary Resource usage Process cost



Process duration To get the process duration information, select the simulation result element and Dynamic Analysis → Process Cases Analysis → Process Duration:  When prompted, select All process instances.  When prompted, click Yes for the Path Signatures. This analysis shows process elapsed duration and throughput details for each process case in a simulation. Process elapsed duration is the duration that a process case takes if started at a specific time and date. Process elapsed duration includes transfer times between activities and the elapsed durations of all activities on the critical path. The critical path is defined as the processing path that has the longest duration of all parallel paths in the process case. Calculations are performed per case by getting the simple average of the process instances duration records in a case. You can use this analysis when you want to examine process level processing durations and throughputs for each generated process case. This analysis, like other process case analysis, may reveal unexpected results within specific process cases.
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For example, you may determine that the average throughput in a particular process case is unacceptably low. As a result of reviewing the information that this analysis presents, you may decide that you need to modify the process model or reset resource levels, or you may determine that you want to investigate further with another type of process case analysis such as process resource analysis. Alternatively, you can examine the duration results for specific process instances within a process case by running the process instance summary analysis and then the process instance time analysis. In the summary the process instances analysis shows four cases that reflect four different ways of processing of customers requests (Figure 5-23).



Figure 5-23 Process duration analysis



Select a case and a blue line in the process diagram shows the path:  The first case reflects a shipped product for a new customer (with new customer entry in the company database).  The second case reflects a cancelled order for a new customer.  The third case reflects a shipped product for an existing customer.  The fourth case reflects a cancelled order for an existing customer. At this point, we can validate that of 270 requests only 68% (34.07 + 34.07) were shipped to customers. One of the goals of the improvement will be to increase this percentage. Another type of analysis can be done with the simulation tool. If you know how long your customers can wait for a product and you want to know how long your company can wait before taking corrective action. You can run the simulation for many durations (1 day, 2 days, 1 week, 2 weeks, 4 weeks, 8 weeks). As a result you can see the curve of order handling duration and the average delay to ship a product to a customer (Figure 5-24).
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For instance, if your customer can wait 100 days for a product, we have to take an action (for example, add a new shipper) after 4 weeks of running. Or we can choose to improve your process to get a more linear result.



100 days



4 weeks



Improvement goal Figure 5-24 Order handling average duration curve



Conclusion of the business analyst The business analyst detects an abnormal behavior and a bottleneck in these results. He should analyze the worst case to figure out the resource problem. Now we know that we cannot sustain the current process in the long run.



Process cases summary To see the process cases summary, select simulation result element and Dynamic Analysis → Process Cases Analysis → Process Cases Summary. The process cases summary analysis (Figure 5-25) shows summary details for all the process cases produced during the simulation of a process. A process case is defined as a set of process instances that have the same processing path. You can use this analysis when you want an overview of the process cases generated in a simulation. This analysis provides high level summary information for each process case, including duration and cost information and an indicator whether the process case was successful or not. This analysis lists the activities completed in each case and quantifies their average total cost and average total elapsed duration.
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This analysis—like other process case analysis—may reveal unexpected results within specific process cases. For example, you may determine that the average process elapsed duration in a particular process case is unacceptably high. As a result of reviewing the information that this analysis presents, you may decide that you need to modify a process model or reset resource levels, or you may determine that you want to investigate further with another type of process case analysis or process instance analysis. Alternatively, you may investigate the reasons that cause a particular process case to fail.



Figure 5-25 Process cases summary



If we analyze details of the two worst cases (case 1 and case 4), we can see what the time consuming activities are (Figure 5-26).



Figure 5-26 Process cases 1 and 4 analysis in detail



Chapter 5. Simulating and analyzing the current process



77



We find that the high consuming activities are Enter Account Number and Enter Order Information. The Receive Order subprocess that contains the two consuming activities, is the first bottleneck of the current process.



Conclusion of the business analyst Several customer surveys have indicated that ClipsAndTacks' customers are not satisfied with the ordering process. The telephone ordering procedure is time-consuming, and customers are frustrated at being placed on hold while waiting for the next available representative. Regular customers are frustrated at the amount of time it takes to receive their orders. These delays are caused by the enter order information process, requiring lot of time to the customer service representative. The process cases summary enables us to assign the delays to the enter order information and account number activities. Now we have to look inside those activities to figure out which resource is an issue.



Resource usage To see the resource usage, select the simulation result element and Dynamic Analysis → Aggregated Analysis → Resource Usage. This analysis shows information about usage of each resource that is allocated in a process simulation. This analysis helps in resource planning as it enables you to see how each resource is allocated to different activities across the process. In addition to showing how a resource uses its time to accomplish one or more activities, this analysis shows where shortages of resources cause delays in completing activities. You can use this information to determine where additional resources are required. We take a look on the enter order information activity (Figure 5-27) to identify which resources to analyze. In this activity two resources are used. One resource is a bulk resource, so this resource cannot be the bottleneck. The other resource is the customer service representative. We have to look in the resource usage analysis if this resource has high shortage duration.
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Figure 5-27 Handling Order (Current): Review Order: Enter order information



The resource usage sheet (Figure 5-28) shows the exponential growth of the shortage duration for the customer service representative. This demonstrates that the customer service representative is really the bottleneck of this process.



expand the list



.....................................................................



Figure 5-28 Customer service representative shortage duration
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Conclusion of the business analyst This analysis shows the overbooking of the customer service representative and the result in term of shortage durations. To fix this problem, two solutions can be proposed:  Add a new customer service representative  Transfer activities from the customer service representative to the customer by introducing a Web application to enter orders. In response to this bottleneck, the new process will eliminate the need for contact between customers and customer service representatives when an order is placed. Customers will be able to browse the ClipsAndTacks product catalog and enter their own order information using a Web application. New customers will be able to enter their company information and receive a customer account number immediately. Customers who have an account number will be able to enter it and prompt the Web application to retrieve their information and pre-fill the Web form with their address and preferred shipping information. The new Web application, including the product catalog and order form, will be available 24 hours a day, 7 days a week.



Process cost To see the process cost, select the simulation result element and Dynamic Analysis → Process Cases Analysis → Process Cost. The process cost analysis shows the average cost and revenue for all process instances in each case in the current simulation result, and the weighted average costs and revenues for all process cases (Figure 5-29). You can use this analysis when you want to examine process level costs and revenues for each generated process case. This analysis, like other process case analyses, may reveal unexpected results within specific process cases. For example, you may determine that the average profit in a particular process case is unacceptably low. As a result of reviewing the information that this analysis presents, you may decide that you need to modify a process model. You can also examine the cost results for specific process instances within a process case by running the process instance summary analysis and then the process instance cost analysis.
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Figure 5-29 Process cost analysis



During this simulation the average costs were: $16.26 to ship a product for a new customer $15.48 to cancel an order for an existing customer $17.31 to ship a product for an existing customer $14.43 to cancel an order for a new customer



   



 The average cost for the process is $16.22 Note: Suppose you want to know the number of order cancelled by customers. You assume how long the customers can wait for a product. Then populate the duration limit in the Ship Order to Customer activity, Duration tab, Resource wait time field. With this parameter, every order not shipped due to a very long processing duration will be considered a failed instance.



Closing reports To close a report use the arrow pull-down select Close.



in the Dynamic Analysis view and



Other reports There are many more dynamic analysis reports that you can explore. Experiment with the Dynamic Analysis menus to view more reports.



More information For more information about Analysis, refer to the product documentation under Analyzing models and simulations.
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Summary The simulation and analysis of the current process model shows significant bottlenecks that must be reduced to keep the current customers happy and to handle future increase in customer demand.
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Chapter 6.



Modeling the Future 1 business process This chapter describes how the ClipsAndTacks current process is modified to become the Future 1 process. The key to a successful transformation of the current process is to define step by step all the information acquired by the business analyst. The first part of this chapter describes the result of the current process analysis. The second part of this chapter shows how the business analyst modifies the process step-by-step to build the new process using WebSphere Business Modeler. No simulation information is populated at this phase. The third part of this chapter shows how the IT architect populates the technical information in accordance to the BPEL technical constraints. Typically the business analyst would consult with the systems architect to discuss implementation issues.



© Copyright IBM Corp. 2006. All rights reserved.
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Documenting the Future 1 process The Future 1 model enables an organization to capture the potential results of any changes it makes to its process. The Future 1 model does not only provide simulation data and analysis; it will serve as a blueprint for the solution architect and programmers whose responsibility it is to create and implement the new runtime process.



Business revision The management of ClipsAndTacks wants to improve the company's revenue by improving its order handling process. The assumption is that a shorter wait time for orders and fewer rejected orders will improve customer satisfaction and result in increased new and repeat business for the company. In the ClipsAndTacks scenario, you will use the current process model as the starting point for the planned revisions to the process model. The key changes in the revised process:  A Web application enables customers to enter their own account and order information.  Orders are sent for review or shipping depending on a new business rule, where the threshold value for automatically approved orders is raised to $750. The business analyst and the management team have determined that the current order handling rule—that is, orders over a certain amount must be approved by an order manager—should remain in place in the new process, but that the rule has to be enhanced. The threshold will be raised from $500 to $750 to reduce the number of orders requiring approval. The business analyst believes that the raised threshold will reduce demand on the order approver, thus speeding up the approvals process for those orders that require it, and reducing the average order completion time. Summary of revisions:  In the Receive Order process, customer service representatives are replaced by a single Web Application that provides customer and product information (shorten order process).  Orders are accepted 24 hours a day, 7 days a week.  Customer completes the Web order form and submits the order; no customer service representatives are required in this process (reduce labour costs).  Orders are checked automatically against a business rules engine.  Regular customer orders over $750 must be approved by the order manager (shorten average order time and increase percentage of approved orders).
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Flow revision The new order handling process contains many of the same activities, but the actors in the process have changed. The process proceeds as shown in Figure 6-1.



The customer visits the ClipsAndTacks Web site: Enter the account number or create an account Enter the order information. Submit the order Approve order or send for review, based on a business rules: If order under state.log db2 disconnect STATE echo STATE is finished db2 connect to RUNTIME db2 -tvf runtime.ddl > runtime.log db2 disconnect RUNTIME echo RUNTIME is finished db2 connect to HISTORY db2 -tvf datamart.ddl > datamartHistory.log db2 disconnect HISTORY echo HISTORY is finished Figure 12-10 Sample batch file to execute the database DDL



304



Business Process Management: Modeling through Monitoring



Setup additional tables for replication Now we execute the four batch files that generate the tables. These batch files run Java code so the PATH must be setup to include Java, for example: set PATH=F:\IBM\WebSphere\ProcServer\java\bin;%PATH% \State_to_Runtime_setup_source.bat \State_to_Runtime_setup_target.bat \Runtime_to_Historical_setup_source.bat \Runtime_to_Historical_setup_target.bat



When prompted a user ID just hit enter. The schema generator takes some time and displays a lot of text in each command window. Again you may want to make a batch file (execSchema.bat) for the above commands to deploy models easier (Figure 12-11).



@echo off set path=F:\IBM\WebSphere\ProcServer\java\bin;%PATH% echo Executing the batch files now... call State_to_Runtime_setup_source.bat echo State_to_Runtime_setup_source.bat is done. call State_to_Runtime_setup_target.bat echo State_to_Runtime_setup_target.bat is done. call Runtime_to_Historical_setup_source.bat echo Runtime_to_Historical_setup_source.bat is done. call Runtime_to_Historical_setup_target.bat echo Runtime_to_Historical_setup_target.bat is done. echo All batch files are finished Figure 12-11 Sample batch file to execute the schema



Note: Do not interrupt execution of these commands even when it appears to be stopped, as some of the database creation operations from these batches can take some time. When all four batch files (or the execSchema.bat) have completed, locate four newly created batch files that begin with the words: StartCapture and StartApply. You should find files similar to these, although the exact filenames will be different each time the schema generator runs: \State_to_Runtime\source\StartCapture_5.bat \State_to_Runtime\target\StartApply_12.bat \Runtime_to_Historical\source\StartCapture_5.bat \Runtime_to_Historical\target\StartApply_12.ba
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Starting the database replicators Execute each of the four batch files. These files launch the DB2 replicators for the business process model. You may create a batch file (startReplicators.bat) as shown in Figure 12-12, to be run from the base directory.



echo call call call call



Starting Replicators State_to_Runtime\source\StartCapture_5.bat State_to_Runtime\target\StartApply_12.bat Runtime_to_Historical\source\StartCapture_5.bat Runtime_to_Historical\target\StartApply_12.bat



Figure 12-12 Sample batch file for DB2 replicators



The four filenames in this batch file are only valid for the last model that was deployed. You may use this to start the replicators for this model version. When you deploy another version of the model, you must ensure that the StartCapture and StartApply filenames that are regenerated are replaced in this batch file. Note: Do not close any of the four background DB2 replicator command windows that are launched! This is normal operation for the Monitor Server. Figure 12-13 shows an example of executing the startReplicators.bat file and the four DB2 replicator command windows that it launches.



Figure 12-13 DB2 Replicators started with batch file, startReplicators.bat
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Deploying the business measures Now we can actually deploy the business measures model into Monitor Server:  Return to WebSphere administrative console and select WebSphere Business Monitor → Server → Business Measures Model → Model Import.  Click Browse to locate the Monitor.zip file, which is located in the same folder. Note that this file is not the same Monitor.zip file exported from the Modeler.  Click Import. This will take some time, depending upon the complexity of your model. Wait until you see the confirmation screen, stating that the Import was successful (Figure 12-14).



\Monitor.zip



Figure 12-14 Business measure import successfully completed
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Importing the DB2 Cube Views We have now fully deployed the model into the Monitor Server, however prior to taking measurements and collecting event data, we must import the DB2 Cube Views generated model using the DB2 Cubes OLAP Center:  Start OLAP Center by selecting Start → Programs → DB2 → Business Intelligence Tools → OLAP Center.  Enter the name of your history database, HISTORY, the db2admin user ID and password.  You receive a message dialog the first time using the OLAP Center. Click Yes, then from menu select: OLAP Center → Import.  Browse to the directory containing the generated model and select the file: \model_cv.xml.  Click Next. When the cube models have been loaded into the OLAP center, you receive a confirmation (Figure 12-15).



Figure 12-15 ClipsAndTacks: Order handling cube model view



 Click Finish.
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Important: For the Clips and Tacks database topology, this last step of loading the cube views model definitions into DB2 OLAP was performed on the Monitor Server machine because the HISTORY database resides on this machine. Normally, for performance reasons, the HISTORY database would reside on the Monitor Dashboard machine, and you would import the cube views model definitions into DB2 OLAP on the Monitor Dashboard machine. You have now completed the business measures model deployment procedure into the WebSphere Business Monitor Server.



Configuring alerts for the adaptive action manager This section we complete our configuration of the Monitor Server environment for the ClipsAndTacks scenario by configuring situation events within the Monitor Server administrative console:  Select WebSphere Business Monitor → Adaptive Action Manager → Configuration.  Select the LDAP tab. Enter your LDAP URL, LDAP administrator user ID and password (Figure 12-16).



userid password



Authorized user ID and password for LDAP queries. You must have an installed LDAP server in order to configure and use alerts with the action manager.



Figure 12-16 Adaptive action manager LDAP configuration
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The LDAP URL may look like this when fully qualified with port#: ldap://domholsfx.burlingame.ibm.com:389



In our case we use a Domino LDAP server on port 389.  Select Applications → Enterprise Applications and restart the action manager enterprise application IBM_WB_ACTIONMANAGER for these changes to take effect.



Notifications For each situation event that we defined in “Situation events” on page 176 we define a notification template for the action to be taken when the event occurs:  In the administrative console and select WebSphere Business Monitor → Adaptive Action Manager → Template Definitions → Notifications.  Click New and enter a name for the template, for example, Late Order Shipped Alert and a matching description of Late Average Order Shipped Event (Figure 12-17).



Figure 12-17 Action alert notification template configuration



– For type select Alert. – Provide an LDAP query for the user(s) to be notified for this alert: (&(objectClass=inetOrgPerson)(uid=andre))
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The query will be dependent upon your LDAP server, in our case we select the order manager andre. – Enter the subject (Order Handling Alert) and the body: This is an automated alert that the average order handling time exceeds 3 days and 1 hour. Average time is: %Average Order Processing Time%



We defined the attribute Average Order Processing Time in the event. – Click OK.  Define a second template for the Orders Declined Event: – Name—Orders Declined Alert – Description—Orders Declined Event – Body—This is an automated alert that 5 or more orders have been declined (%BusinessSituationName%) – Alert, LDAP Query, Subject—Same as for the first event.  The list of notification templates is shown in Figure 12-18



Figure 12-18 Alert notifications



Situation event binding We have to define when the notifications are sent based on the events. The BusinessSituationName attribute of an event is used to trigger an action. In “Triggering an event by a KPI” on page 177 we set the BusinessSituationName attribute for the two events to: Average shipment is too late 5 orders have been declined



 Select WebSphere Business Monitor → Adaptive Action Manager → Installed Situation Event Binding.
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 Click New and enter the situation event name, and a description. Click Apply. Click Add to select the template to bind for this situation event. In our case we select the Late Order Shipped Alert. Click OK (Figure 12-19).



1 2 3



Figure 12-19 Situation event bindings configuration



 Define the second alert binding in the same way. The two bindings are shown in Figure 12-20.



Figure 12-20 Situation event binding list



Note: The situation events as configured may not change for a new model deployment. This is based on your model and how the alerts were modeled. However, if you are unsure, you should revisit the adaptive action alerts configuration discussed in this section each time you deploy a new business measures model into Monitor.
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Configuration of the Monitor Dashboard In this section we continue with the configuration of the ClipsAndTacks scenario in the Monitor Dashboard Client environment:  First we configure the DB2 Alphablox application through the DB2 Alphablox Administration Web-based client to define the cubes.  Then we configure and personalize the Monitor Dashboard Client within WebSphere Portal Server to provide a certain “look and feel” for the subsequent sections, where we will use our customized dashboards for observing and analyzing data, performing analytics, and generating reports. Note: The prerequisite for this section is a complete installation of the WebSphere Business Monitor V6 Server and Dashboard Client (as described in detail in Appendix B, “Installation of WebSphere Business Monitor” on page 417) in addition to completing the previous section of deploying the ClipsAndTacks model to the Monitor Server.



DB2 Alphablox setup Startup the Portal Server on the Monitor Dashboard Client machine, if not already running. On the Monitor Dashboard Client machine, start the DB2 Alphablox administration client by selecting Start → Programs → IBM DB2 Alphablox 8.3 → AlphabloxAnalytics → DB2 Alphablox Administrative Pages:  Enter the userid admin and the correct password.  Select Administration → Data Sources and click Create. Enter the data as follows: – – – –



Data Source Name: HISTORY Adapter Type: IBM DB2 JDBCType 4 Driver Database Name: Enter your historical database name, HISTORY. Database Username/Password: credentials for the db2admin user



 Accept defaults for the rest and click Save.  Create another data source, with name HISTORY_CUBE and select Adapter Type Alphablox Cube Server Adapter. Click Save. Test both data sources you just created. You will see a dialog window indicating if the connection was successful.  Select Administration → Cubes (Figure 12-21). – Select Enable to the right of the DB2 Alphablox Cube Name.
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– Select HISTORY for Relational Data Source. – Click Enable DB2 Cube Views Settings, select the Cube Model WBI.Order Handling (Future 1), and click Import Cube Definition. – Enter Order Handling (Future 1) as name.



Figure 12-21 DB2 Alphablox Cube setup



 Click OK to save. Important: You must enter the DB2 Alphablox Cube Name exactly as it is spelled in the DB2 Cube Views Settings or your installation will be invalid. Repeat the same procedure for Order Handling (Future 1)-aggregates (Figure 12-22) and Order Handling (Future 1)_Tasks (Figure 12-23).
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Figure 12-22 DB2 Alphablox Cube setup: Aggregates



Figure 12-23 DB2 Alphablox Cube setup: Tasks
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After you have created and saved all three Alphablox Cubes, select Administration → General → Runtime Management → DB2 Alphablox Cubes:  For each of the cubes that you created, click Start. You get a confirmation as shown in Figure 12-24.



Figure 12-24 DB2 Alphablox Cubes: Runtime status screen



 Repeat this for the remaining two cubes and ensure all three DB2 Alphablox Cubes show a status of running. You have now completed the DB2 Alphablox Cubes configuration.
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Monitor Dashboard Client portal customization This section pertains to configuring the Monitor Dashboard Client portlets within WebSphere Portal Server 5.1. For general help on WebSphere Portal Server 5.1, refer to the Administration and Users Guide. We will show some sample screens of how the customizations pertain to usage of the WebSphere Business Monitor Dashboard. Open up the home URL for Monitor Dashboard machine: http://localhost:9081/wps/portal



 Click Log in at the top right Figure 12-25().



Figure 12-25 Monitor Dashboard Login



 Login with the user ID wpsadmin and the correct password.
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 Select Administration, Portlet Management → Portlets, then go to page 11 of the portlets admin page to see the Monitor Dashboard portlets (Figure 12-26).



Figure 12-26 Portal Administration: Monitor Dashboard portlets



Here you will see the available Monitor Dashboard portlets. We suggest that you copy any of these portlets if you want to customize them for your pages, because this would modify the base portlet. Click the Copy Portlet icon to make a copy.  Select Portal User Interface → Manage Pages.  Click New Page and create a page. We name the page Clips and Tacks Portal.  Select the new portal and create sub-pages for your customization. Our customization is shown in Figure 12-27.
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Figure 12-27 Sample ClipsAndTacks portal page administration



 For each page that you add, click the configure page icon portlets you want to add to a given page (Figure 12-28).



to add the
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Figure 12-28 Active instances: Add portlets



 Click Done.  To use that page, click My Portal at the top, then navigate to the page you just created, for example, Active Instances, under Clips and Tacks - Monitor Dashboard page. The first time you access this view, it will tell you it is not configured yet. To configure this view for this page click the on the configure icon at the top right of portlet. You will be able to select the business measure model and measure group that you want to view for this page (Figure 12-29).
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Figure 12-29 Configure the active instances page



 Click Next and select your sorting view options.  Click Next and select filters (if any). We will use all defaults here.  Click Next to get a preview of how this view will appear.  Click Finish to accept this configuration and your page view will look as shown in Figure 12-30.



Figure 12-30 Active instances: Portlet view
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You will repeat this for all of the views that you want to configure on any new pages. There will be many layout options and styles. Please consult the WebSphere Portal Server Administration and Users Guide for additional details. The portlets that we use for ClipsAndTacks are:     



Key Performance Indicators (KPIs) Scorecards Gauges Active Instances Dimensions



Overview of using the Monitor Dashboard Client We end this chapter with a few sample views of what you can expect from the Monitor Dashboard. The real examples for our measurements are shown in “Measuring the process using the Monitor Dashboard” on page 333.



Active Instances view Figure 12-31 shows the active process instances with an activity drill-down.



Figure 12-31 Active Instances: Activity drill-down



322



Business Process Management: Modeling through Monitoring



Process Diagram view Figure 12-32 shows the graphical process diagram, similar to how the process diagram was built in the Modeler.



Figure 12-32 Process Diagram view
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Other views The other dashboard views (KPIs, Scorecards, and Gauges) are described in Chapter 13, “Measuring the Future 1 process” on page 329 when we measure the ClipsAndTacks application.



Dimensional analysis Figure 12-33 shows a DB2 Alphablox Cube view with dimensional analysis data.



Figure 12-33 Monitor Alphablox Cube Views portlet: Sample view
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Monitor Dashboard export In Chapter 14, “Comparing the measurements and modeling the Future 2 process” on page 357 we will use the dashboard export facility to export runtime Monitor XML data back into Modeler for next cycle in the continuous process improvement lifecycle (Figure 12-34).



Figure 12-34 Export Monitor data



Running the ClipsAndTacks business process The section takes us to the point where we collect the runtime data by creating new process instances of the ClipsAndTacks process model within the WebSphere Process Server. We create new process instances with the ClipsAndTacks Web application and also use the human task management (BPC Explorer or custom human task application) to create different scenario paths through the process. These actions provide the event data that the Monitor Server will receive and process for us to view and analyze the runtime data in the Monitor Dashboard Client using some of the portlets that we customized. The measurement of the ClipsAndTacks application is described in Chapter 13, “Measuring the Future 1 process” on page 329.
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Making changes to the business measures There is a good chance that your initial KPIs and metrics do not deliver the results that you want to get in the Monitor Dashboard. Without changing the running application you may want to change some of the business measures. Here are short guidelines for such a change of business measures:  Use the same Modeler project and do not rename the process. Renaming the process changes the generated activity names.  Change the business measures using the Business Measures editor. The following changes are allowed without problems: – Add a new metric that is not part of a dimensions – Delete a metric – Change formula of a metric calculation Other changes may result in possible problems: – Change the datatype of a metric—Must be deleted/added in the editor, which results in two metrics in the dashboard – Change the string length of a metric (only increase is allowed)—May run into database limits – Changes in indices—Existing indices will be dropped Changes that require a new observation model: – A metric becomes a dimension – Changing the keys of a dimension – Add and delete of metrics to a dimension Note: To create a new observation model requires changing the process name and create an application that runs in parallel to the old application until it can replace the old application. A new observation model uses a new set of DB2 tables in the Monitor databases. This is what we will do in Part 5, “Continuous process improvement” on page 355.  Export the process. Increase the Monitor version number for each update (see Figure 8-38 on page 182). Only keep the Monitor.zip file. You do not re-import the interchange file into Integration Developer.  Backup the Monitor databases (Repository, State, Runtime, History). If anything goes wrong when deploying the updated business measures model you can go back to what you had deployed. Restoring the databases only works if no process application is running (creating events) during deployment.
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 Open the administrative console in the Monitor Server. Navigate to WebSphere Business Monitor → Server → Business Measures Model → Model Unload (Figure 12-35): – Select the model to unload and click Delete or Delete and keep for reporting. The second option keeps the data in the History database.



Figure 12-35 Unloading a model



 When the unload is finished, continue with deploying the business measures model as described in “Business measures model deployment to Monitor” on page 300. This includes schema generation, running the database scripts, and importing the model.  If you encounter errors when running the database scripts you have to backout the changes manually. This is a cumbersome process. Only run one script at a time and verify its outcome before proceeding.



Summary In this chapter we described how to setup the WebSphere Business Monitor for the ClipsAndTacks business process. Setting up the Monitor includes deployment of the business measures model and configuring the Monitor Dashboard.
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Chapter 13.



Measuring the Future 1 process In this chapter we describe how we measure the ClipsAndTacks Future 1 process application by submitting orders, approving or declining the orders, and finally shipping the orders. We describe where to find the information about the process instanced in the DB2 tables used by the Monitor. After processing about 40 orders we use the Monitor Dashboard to view the KPIs and the metrics we setup for the process. We also use dimensional analysis to compare the metrics based on the location (country and city).



© Copyright IBM Corp. 2006. All rights reserved.
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Measurement script Our test environment is not a real ClipsAndTacks application where numerous customers submit their orders. To gather some meaningful results in the Monitor we developed a script to submit orders and process them through the ClipsAndTacks system using the human tasks for processing of the orders. Figure 13-1 shows an extract of the script to submit orders:  A small amount is under $750 and is automatically approved by the business rule.  A big amount is over $750 and requires the order manager for approval.  An amount between about $500 and $750 for customer 22222 is automatically approved, but does not pass the credit check and therefore also goes to the order manager.  We submitted about 40 orders, shipped 33 orders, and declined 7 orders.



Order



Customer



Amount



AutoApprove



1 2 3 4 5



12345 11111 22222 33333 44444



small big small small small



yes no yes yes yes



6 7 8 9 10



12345 11111 22222 33333 44444



big small 740 big small



no yes yes no yes



MgrApprove



yes



Ship-When 2 days 2 3 3 3



NO yes yes



Notif-When



2 3 4 4 4



Figure 13-1 Extract of script to submit orders



Human tasks We processed the human tasks by claiming the process instances, then waiting about 15 minutes before processing. This resulted in a measured processing time in the Monitor. We waited with shipping the order between two and four days to get an average of about three days. The script was designed to give measurements that do not meet the expectations of ClipsAndTacks management so that the process must be improved.
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Tracking the orders in the Monitor databases As described in “Monitor databases” on page 296 the Monitor uses three databases for reporting: State, Runtime, and History. We looked at some of the tables to track the progress of monitoring the process instances. The names of the tables and columns are generated by the schema generator, but through comments added to the tables we could identify the important tables:  One table has a comment of Order Handling (Future 1)—This table stores process instance data.  One table has a comment of Order Handling (Future 1) aggregates monitoring context—This table stores aggregates values such as the KPIs and metrics.  In each table we could find the relevant columns through their comments.



Tables Table 13-1 shows the names of the two tables in each database. Only the prefix of the name is different. The column names are the same in matching tables. Table 13-1 Monitor tables for Order Handling Future 1: instances and aggregates STATE



RUNTIME



HISTORY



WBI.CTX_AU66A1MBLTK GP5BCDTN5GEXGXY



WBI.CTR_AU66A1MBLTK GP5BCDTN5GEXGXY



WBI.FCT_AU66A1MBLTK GP5BCDTN5GEXGXY



WBI.CTX_YVJEKADLON ZXRIV2LNTSYTFCAA



WBI.CTR_YVJEKADLON ZXRIV2LNTSYTFCAA



WBI.FCT_YVJEKADLON ZXRIV2LNTSYTFCAA



State instance table The State table only contains the process instances that are running. We developed a DB2 command to list the table: db2 "select M_4TP2J26MSO21ULEIKTJLICMYKI as orders, M_BR2COUJUNTFCHWLKDOPTYGBULQ as shipped, M_3L5EJ66JHJNPZP2PTUJ3UKINQM as declined, M_WIYQXRWVWXR5BAGZP36SEG33ZI as price, M_BY5BZ5HTFRLL5NXNJLESQIELUA as appYes, M_ILGDHWLBJIEUQ6YOIIBVGMYA1M as appNo, M_BWTSFR2HG2G4ERBGDMQH4ZH4AA as appAuto, M_VMQL2EKF5EVK646JHNP3AIICQ3 as accGood, SUBSTR(M_BCGKIBDDUHC5TB52LNLQ465HVU,1,8) as state from WBI.CTX_AU66A1MBLTKGP5BCDTN5GEXGXY"
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ORDERS SHIPPED DECLINED PRICE APPYES APPNO APPAUTO ACCGOOD STATE ------ ------- -------- --------- ------ ----- ------- ------- ------1 0 0 +2.762E+3 1 0 0 0 Running



– APPYES and APPNO are the actions of the order manager for approval – APPAUTO is automatic approval – ACCGOOD is account in good standing The shipped and declined counters are only updated when the instance is complete, and then it disappears quickly from the State database after being replicated to the Runtime database.



Runtime instance table The Runtime instance table contains the process instances of the last 24 hours. ORDERS SHIPPED DECLINED PRICE APPYES APPNO APPAUTO ACCGOOD STATE ------ ------- -------- --------- ------ ----- ------- ------- -------1 1 0 +3.002E+3 1 0 0 0 Complete 1 1 0 +1.500E+2 0 0 1 1 Complete 1 0 1 +6.890E+2 0 1 1 0 Complete ...... 1 0 0 +2.762E+3 1 0 0 0 Running



Note that the shipped or declined counter is now updated.



History instance table The History instance table contains all the process instances. The process state is a numeric value indicating complete (1) or running (3). ORDERS SHIPPED DECLINED PRICE APPYES APPNO APPAUTO ACCGOOD STATE ------ ------- -------- --------- ------ ----- ------- ------- ----1 1 0 +3.002E+3 1 0 0 0 1 1 1 0 +1.500E+2 0 0 1 1 1 1 0 1 +6.890E+2 0 1 1 0 1 ...... 1 0 0 +2.762E+3 1 0 0 0 3



Aggregate tables The State and Runtime aggregate tables have the same data (after replicating). We developed a DB2 command to list the relevant values: db2 "select M_GJVBXM64SZRZL6VFRO2JPFWOKU as orders, M_WNV1IMBIC1WCOKHNMRSUMNPDXI as shipped, M_XCRBHPQDRKN5RK5WSS4USORG33 as declined, DECIMAL(M_SQ4UXZLTJYW6HBZFX3AWUFA3DQ,8,2) as percentage, DECIMAL(M_ZET4V1C2PZF1RKFZEC3WA2OA3Y / 86400000.000,7,3) as time from WBI.CTR_YVJEKADLONZXRIV2LNTSYTFCAA"
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ORDERS SHIPPED DECLINED PERCENTAGE TIME ------ ------- -------- ---------- -------41 34 7 82.92 3.122



 The PERCENTAGE column has the comment 90 Percent of Orders Are Approved, therefore it is our KPI of the percentage of approved orders.  The TIME column has the comment Average Order Fulfillment Time is 3 Days or Less, therefore it is our KPI of the order processing time. Note that this time column value is in milliseconds and by dividing by 86400000 we get days. The History aggregate table does not contains the KPI and metrics.



Measuring the process using the Monitor Dashboard Measuring the process using the Dashboard Client component of WebSphere Business Monitor Version 6.0 enables users to monitor business performance through a set of views. The Dashboard Client operates within the IBM WebSphere Portal Version 5.1 environment. Each of the dashboard views is implemented as a portlet. A dashboard is created by assembling portlets in a portal page. To construct the WebSphere Business Monitor Dashboard Client, you create a portal page and add a set of views portlets to it. Users can display the monitoring data through a set of dashboard views defined according to display properties and content. These views provide different representations of both runtime and historical data. DB2 Alphablox is used with the views for a more refined data analysis. We describe and navigate through the following dashboard views:  Runtime views – Active Instances view – Process Diagram view  Historical views – – – –



Scorecard view Key Performance Indicators (KPI) view Gauges view Dimensions view



In additional we provide the steps to create a new view using the Dimensions view as a base.
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Navigating through the Dashboard Client with runtime views The Dashboard Client allows users to view the executing instances, view their associated business measures and perform administrative actions, such as suspend, resume, and terminate a selected instance. Viewing the details of this runtime analysis can help you to closely monitor your business processes.



Active Instances view The Active Instances view shows the details of a process at run time. It displays information about running instances as they happen. Using the Active Instances view, you can monitor values of KPIs and metrics that belong to an aggregate business measures group. The available process instances for a selected business measure group are displayed. You can view and monitor the values of their associated KPIs, metrics, stopwatches, and counters. You can drill down on child instances of a parent instance to view the underlying activities, for example, items in process instances, whether they are realized by activities, local subprocesses, or global subprocesses. The Active Instances portlet is shown in (Figure 13-2). It consists of a Active Instances table that displays the business measures of each currently running process instance.



Figure 13-2 Active Instances view portlet
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Details of an active instance Additional measures can be viewed, for example when you click the small arrow at the Activities column you will drill down to the detail view of each activity of the process instance (Figure 13-3).



Figure 13-3 Active Instances view: Details



In the first column you can see the Activity State for the select process instance. We have two activities already completed and one ready to work on. Notice that this activity has not been started yet, indicated by the date of Dec 31, 1969 in the Activity Start Time column. Once a user works on this activity, the Activity State is set to Running and the Activity Start Time is a current value (Figure 13-4).



Figure 13-4 Detail Active Instances view per activities
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Sorting active instances by business measures In the Dashboard Client, a user can customize their view of the Active Instances portlet by sorting different measures and setting the number of rows to display (Figure 13-5). To sort the activities on the Active Instances portlet click the Edit icon .



Figure 13-5 Sorting active instances by business measures



Filtering active instances by business measures You can control the instances displayed in the Active Instances view by setting a filter expression in configure mode or edit mode. When you limit the number or type of instances in a view, you can focus on a particular area of interest. In the filter dialog (Figure 13-6), you can display instances that satisfy certain criteria that you define during the configuration or the personalization of the Active Instances view. By setting filtering criteria based on one or more business measures, you can determine which process instances will be displayed in view mode in the Active Instances view. You can build a formula of business measures and specific values that represents the filter expression. The filter expression can be simple or complex:  A simple expression consists of a filter criterion based on only one business measure.  A complex expression includes filter criteria based on multiple business measures, combined together by boolean operators, such as AND, OR, and NOT. Each criterion in the filter expression is defined by specifying a value—or a range of values—for the measure you select. The values for measures are based on the nature of each business measure.
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For example, a numeric business measure requires a numeric value and a logical operator. A duration business measure requires an operator (for example, 
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